Manual Part No. 28-0172
February, 2016

Copyright © 2000—2016 Harmonic Inc. All rights reserved. Harmonic, the Harmonic logo, Omneon, and the Omneon logo, all other Harmonic products mentioned are trademarks, registered trademarks or service marks of Harmonic Inc. in the United States and other countries. Dolby, Dolby Digital, Dolby Digital Plus and Dolby E are registered trademarks of Dolby Laboratories. Implementations of AAC and HE-AAC by Fraunhofer IIS. Other company, product and service names mentioned herein may be trademarks or service marks of their respective owners. All product and application features and specifications are subject to change at Harmonic’s sole discretion at any time and without notice.

Disclaimer
Harmonic reserves the right to alter the equipment specifications and descriptions in this publication without prior notice. No part of this publication shall be deemed to be part of any contract or warranty unless specifically incorporated by reference into such contract or warranty. The information contained herein is merely descriptive in nature, and does not constitute a binding offer for sale of the product described herein. Harmonic assumes no responsibility or liability arising from the use of the products described herein, except as expressly agreed to in writing by Harmonic. The use and purchase of this product do not convey a license under any patent rights, copyrights, trademark rights, or any intellectual property rights of Harmonic. Nothing hereunder constitutes a representation or warranty that using any products in the manner described herein will not infringe any patents of third parties.

Third-Party Product Trademarks
Adobe® After Effects®, Photoshop®, Flash® Professional, Premiere®
Avid® Media Composer®
Dolby®, E, Dolby Digital, Dolby Digital Plus
Jünger Audio®
Apple® QuickTime®
Microsoft® Mediaroom®
Microsoft® PlayReady®
DOCSIS®: 3.0
Start Over® TV

Third-Party Copyright Notes
Dolby is a registered trademark of Dolby Laboratories. Dolby Digital, Dolby Digital Plus, Dolby Pulse, aacPlus, AC-3, and Dolby E are trademarks of Dolby Laboratories.
Level Magic and Jünger are trademarks of Jünger Audio Studiotechnik GmbH.
MPEG Audio technology licensed from Fraunhofer IIS http://www.iis.fraunhofer.de/amm/
PitchBlue® is a registered trademark of Vigor Systems.
QuickTime and the QuickTime logo are trademarks or registered trademarks of Apple Computer, Inc., used under license therefrom.

Trademark Acknowledgments
Harmonic and all Harmonic product names are trademarks of Harmonic Inc. All other trademarks are the property of their respective owners.
The software described in this document is furnished under a license agreement or nondisclosure agreement. The software may be used or copied only in accordance with the terms of those agreements.

May be covered by one or more of U.S. Patents No. 6,571,351; 6,696,996; 6,545,721; 6,574,225; 6,895,003; 6,522,649; 6,643,702; foreign counterparts and pending patent applications.
This system is distributed with certain other software that may require disclosure or distribution of licenses, copyright notices, conditions of use, disclaimers and/or other matter. Use of this system or otherwise fulfilling their conditions constitutes your acceptance of them, as necessary. Copies of such licenses, notices, conditions, disclaimers and/or other matter are available in any one of the following locations: the LEGAL NOTICES AND LICENSES directory of the distribution disk of the software, the root directory of the hard disk drive of the Products, or by contacting us at support@harmonicinc.com.

Notice
Information contained in this guide is subject to change without notice or obligation. While every effort has been made to ensure that the information is accurate as of the publication date, Harmonic Inc. assumes no liability for errors or omissions. In addition, Harmonic Inc. assumes no responsibility for damages resulting from the use of this guide.

License Agreement and Limited Warranty
1. AGREEMENT: This is a legal agreement (“Agreement”) between you (“you” or “your”) and Harmonic, or its appropriate local affiliate (“Harmonic”, “we”, “us” or “our”). Use of our products and any updates thereto purchased or validly obtained by you (the “Products”), and/or the Software (as defined below) (collectively, the “System”), constitutes your acceptance of this Agreement. “Use” includes opening or breaking the seal on the packet containing this Agreement, installing or downloading the Software as defined below or using the Software preloaded or embedded in your System. As used herein, the term “Software” means the Harmonic owned software and/or firmware used in or with the Products and embedded into, provided with or loaded onto the Products in object code format, but does not include, and this Agreement does not address, any third-party or free or open source software separately licensed to you (“Third Party Software”). If you do not agree to this Agreement, you shall promptly return the System with a dated receipt to the seller for a full refund.
2. LICENSE: Subject to the terms and conditions of this Agreement (including payment), we hereby grant you a nonexclusive, nontransferable license to use the object code version of the Software embedded into, provided solely for use with or loaded onto the Product, and the accompanying documentation ("Documentation") for your internal business purposes. The Software and any authorized copies are owned by us or our suppliers, and are protected by law, including without limitation the copyright laws and treaties of the U.S.A. and other countries. Evaluation versions of the Software may be subject to a time-limited license.

3. RESTRICTIONS: You and your employees and contractors shall not attempt to reverse engineer, disassemble, modify, translate, create derivative works of, rent, lease including use on a timesharing, applications service provider, service bureau or similar basis), loan, distribute, sublicense or otherwise transfer the System, in whole or part except to the extent otherwise permitted by law. The Software may be operated on a network only if and as permitted by its Documentation. You may make one (1) back up copy of the object code of the Software for archival purposes only. Evaluation Software will be run in a lab, nonproductive environment. Results of any benchmark or other performance tests may not be disclosed to any third party without our prior written consent. Title to and ownership of the Software and Documentation, including all copyright, patent, trade secret, trademark, and other intellectual property rights in the System, shall remain our or our licensors' property. You shall not remove or alter any copyright or other proprietary rights notices on the System. We reserve all rights not expressly granted.

4. LIMITED WARRANTY: (a) Limited Warranty. We warrant to you that, commencing on your receipt of a Product and terminating 1 year thereafter, the System will perform substantially in accordance with its then-current appropriate Documentation. The Product (including replacements) may consist of new, used or previously-installed components. (b) Remedies. If the System fails to comply with such warranty during such period, as your sole remedy, you must return the same in compliance with our product return policy, and we shall, at our option, repair or replace the System, provide a workaround, or refund the fees you paid. Replacement Systems are warranted for the original System's remaining warranty period. (c) Exclusions. EVALUATION SOFTWARE IS LICENSED ON AS-IS BASIS AND SUBJECT TO 4(d). We will have no obligation under this limited warranty due to: (i) negligence, misuse or abuse of the System, such as unusual physical or electrical stress, misuse or accidents; (ii) use of the System other than in accordance with the Documentation, software modifications, alterations or repairs to the System made by a party other than us or our representative; (iii) the combination, operation or use of the System with equipment, devices, software or data not supplied by us; (iv) any third party hardware or Third Party Software, whether or not provided by us; (v) any failure other than by us to comply with handling, operating, environmental, storage or maintenance requirements for the System in the Documentation, including, without limitation, humidity, temperature, or security measures; (vi) failure of any third party hardware or software; (vii) any use of your own or any third party's data, devices, software or data not supplied by us; and (viii) any failure other than by us to comply with handling, operating, environmental, storage or maintenance requirements for the System in the Documentation, including, without limitation, humidity, temperature, or security measures. The Software may be operated on a network only if and as permitted by its Documentation. (b) Remedies. If the System fails to comply with such warranty during such period, as your sole remedy, you must return the same in compliance with our product return policy, and we shall, at our option, repair or replace the System, provide a workaround, or refund the fees you paid. Replacement Systems are warranted for the original System's remaining warranty period. (c) Exclusions. EVALUATION SOFTWARE IS LICENSED ON AS-IS BASIS AND SUBJECT TO 4(d). We will have no obligation under this limited warranty due to: (i) negligence, misuse or abuse of the System, such as unusual physical or electrical stress, misuse or accidents; (ii) use of the System other than in accordance with the Documentation, software modifications, alterations or repairs to the System made by a party other than us or our representative; (iii) the combination, operation or use of the System with equipment, devices, software or data not supplied by us; (iv) any third party hardware or Third Party Software, whether or not provided by us; (v) any failure other than by us to comply with handling, operating, environmental, storage or maintenance requirements for the System in the Documentation, including, without limitation, humidity, temperature, or security measures; (vi) failure of any third party hardware or software; (vii) any use of your own or any third party's data, devices, software or data not supplied by us; and (viii) any failure other than by us to comply with handling, operating, environmental, storage or maintenance requirements for the System in the Documentation, including, without limitation, humidity, temperature, or security measures.

5. LIMITATION OF LIABILITY: WE AND OUR AFFILIATES, SUPPLIERS, LICENSORS, OR SALES CHANNELS ("REPRESENTATIVES") SHALL NOT BE LIABLE TO YOU FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE, OR EXEMPLARY DAMAGES OF ANY KIND, INCLUDING BUT NOT LIMITED TO LOST REVENUES, PROFITS OR SAVINGS, OR THE COST OF SUBSTITUTE GOODS, HOWEVER CAUSED, UNDER CONTRACT, TORT, BREACH OF WARRANTY, NEGLIGENCE, OR OTHERWISE, EVEN IF WE WERE ADVISED OF THE POSSIBILITY OF SUCH LOSS OR DAMAGES. NOTWITHSTANDING ANY OTHER PROVISIONS OF THIS AGREEMENT, WE AND OUR REPRESENTATIVES' TOTAL LIABILITY TO YOU ARISING FROM OR RELATING TO THIS AGREEMENT OR THE SYSTEM SHALL BE LIMITED TO THE TOTAL PAYMENTS TO US UNDER THIS AGREEMENT FOR THE SYSTEM. THE FOREGOING LIMITATIONS SHALL NOT APPLY TO DEATH OR PERSONAL INJURY TO PERSONS OR TANGIBLE PROPERTY IN ANY JURISDICTION WHERE APPLICABLE LAW PROHIBITS SUCH LIMITATION. YOU ARE SOLELY RESPONSIBLE FOR BACKING UP YOUR DATA AND FILES, AND HEREBY RELEASE US AND OUR REPRESENTATIVES FROM ANY LIABILITY FOR DAMAGES DUE TO THE LOSS OF ANY SUCH DATA OR FILES. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO SUCH EXCLUSIONS MAY NOT APPLY TO YOU.

6. CONFIDENTIALITY: Information in the System and the associated media, as well as the structure, organization and code of the Software, are proprietary to us and contain valuable trade secrets developed or acquired at great expense to us or our suppliers. You shall not disclose to others or utilize any such information except as expressly provided herein, except for information (i) lawfully obtained by the user from a third party which is not subject to confidentiality obligations; (ii) generally available to the public without breach of this Agreement; (iii) lawfully known to the user prior to its receipt of the System; or (iv) required by law to be disclosed.

7. SUPPORT: Updates, upgrades, fixes, maintenance or support for the System (an “Upgrade”) after the limited warranty period may be available at separate fee.

8. TERM, TERMINATION. The term of this Agreement shall continue unless terminated in accordance with this Section. We may terminate this Agreement at any time upon default by you of the license provisions of this Agreement, or any other material default by you of this Agreement not cured with thirty (30) days after written notice thereof. You may terminate this Agreement at any time by terminating use of the System. Except for the first sentence of Section 2 (“License” and for Section 4(a) (“Limited Warranty”), all provisions of this Agreement shall survive termination of this Agreement. Upon any such termination, you shall certify in writing such termination and non-use to us.

9. EXPORT CONTROL: You agree that the Products and Software will not be shipped, transferred, or exported into any country or used in any manner prohibited by the United States Export Administration Act or any other export laws, restrictions, or regulations (the "Export Laws"). You will indemnify, defend and hold us harmless from any and all claims arising therefrom or relating thereto. In addition, if the Products or Software are identified as export controlled items under the Export Laws, you represent and warrant that you are not a citizen, or otherwise located within, an embargoed nation (including without limitation Iran, Iraq, Syria, Sudan, Libya, Cuba, North Korea, and Serbia) and that you are not otherwise prohibited under the Export Laws from receiving the Software. All rights to the Products and Software are granted on condition that such rights are forfeited if you fail to comply with the terms of this Agreement.

10. U.S. GOVERNMENT RIGHTS: The Software and the documentation which accompanies the Software are "Commercial Items," as that term is defined at 48 C.F.R. §2.101, consisting of "Commercial Computer Software" and "Commercial Computer Software Documentation," as such terms are used in 48 C.F.R. §12.212 or 48 C.F.R. §227.7202, as applicable. Consistent with 48 C.F.R. §12.212 or 48 C.F.R. §§227.7202-1 through 227.7202-4, as applicable, the Commercial Computer Software and Commercial Computer Software Documentation are licensed to U.S. Government as end user(s) only as Commercial Items and (b) with only those rights as are granted to all other end users pursuant to the terms and conditions herein. Harmonic, 4300 North First Street, San Jose, CA 95134 U.S.A.

11. GENERAL: You shall not assign, delegate or sublicense your rights or obligations under this Agreement, by operation of law or otherwise, without our prior written consent. This Agreement binds and benefits permitted successors and assigns. This Agreement is governed by California law, without regard to its conflicts of law principles. Neither the U.N. Convention on Contracts for the International Sale of Goods is disclaimed. If any claim arises out of this Agreement, the parties hereby submit to the exclusive jurisdiction and venue of any federal and state courts located in Santa Clara County, California. In addition to any other rights or remedies, we shall be entitled to injunctive and other equitable relief, without posting bond or other security, to prevent any material breach of this Agreement. We may change the terms, conditions and pricing relating to the future licensing of our Systems and other intellectual property rights, including this Agreement, from time to time. No waiver will be implied from conduct or failure to enforce rights nor effective unless in a writing signed on behalf of the party against whom the waiver is asserted. If any part of this Agreement is found unenforceable, the remaining parts will be enforced to the maximum extent permitted. There are no third-party beneficiaries to this Agreement.
Agreement. We are not bound by additional and/or conflicting provisions in any order, acceptance, or other correspondence unless we expressly agree in writing. This Agreement is the complete and exclusive statement of agreement between the parties as to its subject matter and supersedes all proposals or prior agreements, verbal or written, advertising, representations or communications concerning the System.

Every reasonable attempt has been made to comply with all licensing requirements for all components used in the system. Any oversight is unintentional and will be remedied if brought to the attention of Harmonic at support@harmonicinc.com.

**Documentation Conventions**

This guide may use some special symbols and fonts to call your attention to important information. The following symbols appear throughout this guide:

- **DANGER:** The Danger symbol calls your attention to information that, if ignored, can cause physical harm to you.

- **CAUTION:** The Caution symbol calls your attention to information that, if ignored, can adversely affect the performance of your Harmonic product, or that can make a procedure needlessly difficult.

- **LASER DANGER:** The Laser symbol and the Danger alert call your attention to information about the lasers in this product that, if ignored, can cause physical harm to you.

- **NOTE:** The Note symbol calls your attention to additional information that you will benefit from heeding. It may be used to call attention to an especially important piece of information you need, or it may provide additional information that applies in only some carefully delineated circumstances.

- **IMPORTANT:** The Important symbol calls your attention to information that should stand out when you are reading product details and procedural information.

- **TIP:** The Tip symbol calls your attention to parenthetical information that is not necessary for performing a given procedure, but which, if followed, might make the procedure or its subsequent steps easier, smoother, or more efficient.

In addition to these symbols, this guide may use the following text conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typed Command</td>
<td>Indicates the text that you type in at the keyboard prompt.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt;, &lt;Ctrl&gt;+&lt;Shift&gt;</td>
<td>A key or key sequence to press.</td>
</tr>
<tr>
<td><strong>Links</strong></td>
<td>The <em>italics in blue</em> text to indicate Cross-references, and hyperlinked cross-references in online documents.</td>
</tr>
<tr>
<td><strong>Bold</strong></td>
<td>Indicates a button to click, or a menu item to select.</td>
</tr>
<tr>
<td><strong>ScreenOutput</strong></td>
<td>The text that is displayed on a computer screen.</td>
</tr>
<tr>
<td><strong>Emphasis</strong></td>
<td>The <em>italics</em> text used for emphasis and document references.</td>
</tr>
</tbody>
</table>

**NOTE:** You require Adobe Reader or Adobe Acrobat version 6.0 or later to open the PDF files. You can download Adobe Reader free of charge from www.adobe.com.
# Table of Contents

**Introduction** ................................................................................................................................. 9
- Harmonic SystemManager Documentation Suite ........................................................................ 9
- Locating the Latest Documentation on the Harmonic Website .................................................. 9
- Technical Support ............................................................................................................................ 10
  - Useful Information when Contacting Technical Support .......................................................... 10

**Chapter 1: SystemManager Platforms** ......................................................................................... 14
- Overview .......................................................................................................................................... 14
- NSM-2016, and NSM-2016K SystemManager Platform ................................................................. 15
  - NSM-2016 and NSM-2016K Description .................................................................................. 15
  - NSM 2016/K Front Panel Components ..................................................................................... 16
  - NSM 2016/K Rear Panel Components ....................................................................................... 18
- NSM-2016K SystemManager Platform Keyboard/Monitor Tray ................................................... 20
- NSM-2016SW (Software-Only) SystemManager ............................................................................. 22
  - System Requirements .................................................................................................................. 22
  - Software and Documentation Packaging ................................................................................. 23

**Chapter 2: SystemManager Platform Setup and Configuration** .................................................. 24
- About SystemManager Platform or Client PC Network Setup and Configuration ..................... 24
  - Network Setup ............................................................................................................................. 24
  - Additional Configuration Options .............................................................................................. 25
- Setting Up the SystemManager Platform ....................................................................................... 25
  - Unpacking and Inspection ............................................................................................................. 26
  - Installation Prerequisites ............................................................................................................. 26
  - Installation Block Diagram .......................................................................................................... 26
  - Installing and Powering up a SystemManager Platform .......................................................... 27
  - Powering Down a SystemManager Platform ............................................................................ 28
  - SystemManager Platform Interconnection ................................................................................ 28
  - SystemManager Platform Documentation ................................................................................ 28
- About Anti-Virus and Windows Updates ......................................................................................... 28
- About the FLEXlm License Server ................................................................................................. 29
- About the Web Browser ................................................................................................................... 30

**Chapter 3: Software Installation** .................................................................................................. 31
- Installing, Reinstalling, or Upgrading the SystemManager Application ........................................ 31
  - Obtaining and Installing a SystemManager License File ............................................................ 31
  - Installing, Reinstalling, or Upgrading SystemManager ............................................................... 32
  - Installing Java Runtime Environment ....................................................................................... 40
  - Configuring FLEXlm License Server Data Using the SystemManager .................................. 40
  - Installing a Windows SNMP Agent on SystemManager Client PCs ...................................... 43
  - About Installing vDHCP Server for Windows from the SystemManager Application Installer 45
Table of Contents

Logging on to SystemManager .................................................. 45
Installing or Upgrading Spectrum Firmware ............................... 47
Installing or Upgrading ProBrowse Firmware .............................. 47
Installing or Upgrading Harmonic MediaGrid Firmware ............... 47
Installing or Upgrading ProXchange Firmware ............................. 48
Installing or Upgrading MAS Firmware ..................................... 48
Reinstalling the SystemManager Platform Operating System on NSM-2016 or NSM-2016K 48
Synchronizing Clocks on Spectrum Video Servers and the SystemManager Platforms or Client PCs ........................................ 50
  Synchronizing Clocks on the NSM-2016 or NSM-2016SW Installed on a Client PC 50
  Configuring NTP on Windows 7 ............................................ 51
Accessing Documentation for a Release .................................... 53
  Accessing Documentation from the Windows Start Menu .......... 53
  Downloading the Latest Documentation from Harmonic .......... 53
  Locating the Latest Documentation on the Harmonic Website .... 54

Appendix A: Legacy Platforms ................................................. 55
Overview .................................................................................. 55
NSM-2012 and NSM-2012K SystemManager Platform .................. 56
  NSM-2012 and NSM-2012K Description .................. 56
NSM 2012/K Front Panel Components ..................................... 57
NSM 2012/K Rear Panel Components ...................................... 61
NSM-2012K SystemManager Platform Keyboard/Monitor Tray .... 63
  NSM-2001 and NSM-2003 Description ............................... 65
  NSM-2007 and NSM-2007K Description ....................... 65
  NSM-2003 and NSM-2007K SystemManager Platform Keyboard/Monitor Tray ..... 68
Support for non-English Keyboards ........................................ 68

Appendix B: Contacting the Technical Assistance Center ............ 70

Appendix C: Safety and Regulatory Compliance Information ........ 72
Important Safety Instructions ..................................................... 72
Introduction

This guide provides a detailed orientation to the Harmonic SystemManager Platform, as well as installation instructions for the Harmonic SystemManager application. The SystemManager provides management capabilities for the Spectrum system, Harmonic MediaGrid, ProBrowse System, ProXchange, and Media Application Server (MAS).

This guide contains the following chapters:

- **Introduction** (this chapter)
- **SystemManager Platforms**
- **SystemManager Platform Setup and Configuration**
- **Software Installation**

Harmonic SystemManager Documentation Suite

The following table describes the documents, which comprise the Harmonic SystemManager documentation suite.

Table 0–1: SystemManager Documentation Suite

<table>
<thead>
<tr>
<th>This document...</th>
<th>Provides this information...</th>
</tr>
</thead>
</table>
| **Harmonic SystemManager User Guide and Online Help System** | ■ software installation and upgrade details,  
■ system operations procedures  
■ system configuration procedures  
■ ClipTool installation and operation procedures |
| **Harmonic SystemManager Installation Guide (this guide)** | ■ software installation and upgrade details |
| **Harmonic SystemManager Release Notes** | ■ new features in the SystemManager release  
■ last minute information regarding a product release |

Software updates are available from the Harmonic website. Contact Harmonic Technical Support for login information.

All items are packaged in self-extracting files.

- **SystemManager-v<version#>-Software.exe** contains the SystemManager application and OnlineHelp system.

Acrobat Reader is needed to view the product documentation. Download this for free from [http://www.adobe.com](http://www.adobe.com)

Locating the Latest Documentation on the Harmonic Website

The latest product documentation, as well as information provided for older releases, is available on the Harmonic website at: [http://www.harmonicinc.com/documents-detail](http://www.harmonicinc.com/documents-detail).
Technical Support

For information on contacting Harmonic Technical Support, refer to Appendix B, Contacting the Technical Assistance Center.

Useful Information when Contacting Technical Support

In order to assist Technical Support, review the following information:

- **What version of firmware is installed on your system?**
  
  From the Home tab, click the Upgrade Firmware icon in the left-hand column to display the Upgrade Firmware page. The firmware version for each device is shown in the Current Firmware Version column.

- **What version of SystemManager software is installed?**
  
  From SystemManager, click the Help tab. The version is shown in the Server Software section of the page.

- **Which Windows operating system is running on the SystemManager client PC?**
  
  1. From Windows, click the Start button, and then click Run.
  2. In the Open field, type: winver, and then press Enter to open the About Windows dialog box, which shows the version number.

- **How much memory is installed on the SystemManager platform? (for example, 512 MB, or 1 GB)**
  
  1. From Windows, click the Start button, and then click Run.
  2. In the Open field, type: winver and then press Enter to open the About Windows dialog box. Look for the line which reads “Physical memory available to Windows.”

- **Please provide the manager.oda file from the SystemManager platform or client PC**
  
  Technical Support may request that you email the manager.oda file, which contains configuration information for your system. This file is located on the SystemManager platform at D:\Omneon\Manager\omdb, or if you are using a client PC with a single C: partition, it will be in the same directory on the C: drive.

- **What is the model and serial number of the hardware involved?**
  
  - For Spectrum and MediaDeck devices: from the Home tab, click the Upgrade Firmware icon in the left-hand column to display the Upgrade Firmware page. Both MediaDirectors and MediaDecks are listed in the MediaDirectors section. Find the Model Numbers and Serial Numbers listed in their respective columns.
    
    Scroll down to the MediaPorts section to view the Model Numbers and Serial Numbers for MediaPorts and MediaDeck Modules.
  
  - For Harmonic MediaGrid Devices: Click the Servers & Switches icon in the left-hand column. From the Servers and Switches page, in the Name column, click the link for the Harmonic MediaGrid device to open the Properties page for that device.
  
  - For ProXchange devices: Click the ProXchange Servers icon in the left-hand column. From the Servers page, in the Name column, click the link for the ProXchange device to open the Properties page for that device.
  
  - For ProBrowse devices: Click the ProBrowse Servers icon in the left-hand column. From the Servers page, in the Name column, click the link for the ProBrowse device to open the Properties page for that device.
For MAS devices: Click the MAS Servers icon in the left-hand column. From the Servers page, in the Name column, click the link for the MAS device to open the Properties page for that device.

For Spectrum Systems

- What is the name of the Player that is being used?
  From SystemManager, click the Player Configuration link in the left-hand column, and then click the name of the MediaDirector or MediaDeck. The Player List page for that device appears. The names and status of all players are listed.

- What file format and bit rate is the Player configured for? (for example, MPEG, DV, IMX?)
  1. From SystemManager, click the Player Configuration link in the left-hand column, and then click the name of the MediaDirector or MediaDeck. The Player List page for that device appears.
  2. From the player list, click the Properties link to view all the details for a player.

- If the problem is related to Ingest or Playout of a clip, what is the Clip ID involved?
  The clip name or clip ID should be indicated by whatever software application you are using to play or record video. For ClipTool, clip names are displayed in the clip management area of the ClipTool main window.

- What brand of Automation, if any, is being used for control?

- Is the Automation using VDCP or API for communication control?

For Harmonic MediaGrid Systems

For failures with the Harmonic MediaGrid client:

- What operating system is running on the client computer?
- What applications are you using?
- What version of the Harmonic MediaGrid FSD is installed?

To determine the FSD version on Windows:
  1. From the Control dialog box, click the Add/Remove Programs icon.
  2. Locate the Harmonic MediaGrid File System Driver entry and click the link, which says Click here for support information. The version is displayed.

To determine the FSD version on Macintosh:
  1. Select Find from the File menu.
  2. Click Applications in the Finder sidebar of the Searching "This Mac" window.
  3. Double-click the Connect to MediaGrid icon to open the Connect to Harmonic MediaGrid dialog box.

To determine the FSD version on Linux:

Use the following command: `tail /proc/sys/omfs*`

- Please supply an error message, screen capture, or description of the symptom
- Is the issue repeatable? If so, what is the procedure to reproduce the issue?
- Please supply log files for the client FSD and ContentBridge FSD
Once you are able to reproduce the issue, Technical Support may ask you to provide log files from the client computers or the ContentBridge. The following instructions describe how to turn on logging on a client system.

**IMPORTANT:** Do not perform the following procedures unless directed by Technical Support.

**To enable logging for a Windows client:**
1. Add two registry parameters to the OmRdr registry key:
   - HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\OmRdr\Parameters
     - DWORD “debug” with value 1
     - DWORD “LogToFile” with value 1
2. For debug to take effect, make sure the client is mounted to the Harmonic MediaGrid system.
3. For LogToFile to take effect, run the “taillog” executable and redirect the output to a file. From the **Start** menu, click **Run**, and paste the location of tailog.exe and desired location of the log file into the **Open** field, as shown in this example: “C:\Program Files\Omneon\Omneon MediaGrid\taillog.exe” > c:\clxxxxxx-1.log
   - In this example, the log file will be created at the c:\ directory.
4. Reproduce the issue, and then collect all log files from taillog and the omxxxx.log from the WinFSD installed directory.
5. Once you have collected the log files make sure to delete the LogToFile parameter from the registry, otherwise it will have a negative impact on performance.

**To enable logging for a Macintosh client:**
1. Run the following command to ensure that the debug level is set to default:
   - `sudo sysctl –w debug.omfs=3`
2. Reproduce problem.

**To collect log messages for a Linux client:**
Collect /var/log/messages.

Harmonic may also wish to collect the current configured Linux FSD parameters. Access these by entering the following command:
- `cat /proc/sys/omfs*`

**To collect log messages for the ContentBridge:**
Locate the log file at:/var/log/omneon/remote/<IP address of ContentBridge>.

- **What was the time of the failure?**
  For information on the time of failure, navigate to the **View Alarms** page in SystemManager. To open the View Alarms page, click the **Diagnostics** tab, and then click the **View Alarms** icon in the left-hand column.

**For failures with the Harmonic MediaGrid cluster:**
- **What is the name of the device that experienced the failure?**
  From SystemManager, click the **Servers & Switches** icon in the left-hand column to access the **Servers & Switches** page. Device names are listed in the **Name** column.
- **Please provide an error message and/or a description of the symptom**
- Is this failure affecting clients or other systems?
- Please provide the appropriate log file or remote access to the device

The Harmonic MediaGrid provides logs files for all of the core services. Technical support may wish to view one of these logs to determine the root cause of the problem. The following three log files are used most often when troubleshooting. These files are located on the ContentDirector at /var/log/omneon.

- **ssmd**: SliceServer Manager
- **mdscore**: MetaData Server
- **startup**: Core Harmonic MediaGrid Services Startup and Shutdown
Chapter 1
SystemManager Platforms

This chapter provides information about SystemManager Platforms. The following topics are covered:

- **Overview**
- **NSM-2016, and NSM-2016K SystemManager Platform**
- **NSM-2016K SystemManager Platform Keyboard/Monitor Tray**
- **NSM-2016SW (Software-Only) SystemManager**

For information on legacy SystemManager Platforms, refer to the appendix, *Legacy Platforms*.

**Overview**

The SystemManager is available in the following platform or software-only configurations:

**Table 1–1: Platform Configurations**

<table>
<thead>
<tr>
<th>Model</th>
<th>Hardware</th>
<th>Software</th>
</tr>
</thead>
</table>
| NSM-2016  | - Dell* PowerEdge* R230  
- Intel* Xeon E3-1220v5 series processor 3.0 GHz, 8M Cache  
- 8 GB DDR4  
- Two 500 GB 7200 rpm SATA Hard drives  
- Two integrated 10/100/1000 Mbps network interface controllers (NICs) | - Windows 7 Professional  
- SystemManager Application  
- FLEXlm License Server  
- vDHCP (Spectrum and ProBrowse systems)  
- Microsoft Internet Explorer  
- NTP for Windows  
- Adobe® Reader® |
| NSM-2016K | - Dell* PowerEdge* R230  
- Intel* Xeon E3-1220v5 series processor 3.0 GHz, 8M Cache  
- 8 GB DDR4  
- Two 500 GB 7200 rpm SATA Hard drives  
- Two integrated 10/100/1000 Mbps network interface controllers (NICs)  
- 17-inch flat panel monitor  
- Keyboard  
- Mouse  
- Combination video/USB cable | - Windows 7 Professional  
- SystemManager Application  
- FLEXlm License Server  
- vDHCP (Spectrum and ProBrowse systems)  
- Microsoft Internet Explorer  
- NTP for Windows  
- Adobe® Reader® |
| NSM-2016SW| This is a software only configuration. | - SystemManager Application  
- FLEXlm License Server  
- Microsoft Internet Explorer 7  
- vDHCP (Spectrum and ProBrowse systems)  
- NTP for Windows |
For information on NSM-2016 and NSM-2016K refer to NSM-2016, and NSM-2016K SystemManager Platform. For information about NSM-2016SW, go to NSM-2016SW (Software-Only) SystemManager.

NSM-2016, and NSM-2016K SystemManager Platform

Choose from the following topics:

- NSM-2016 and NSM-2016K Description
- NSM 2016/K Front Panel Components
- NSM 2016/K Rear Panel Components

**NOTE:** The SystemManager Platform consists of hardware and software components provided by other vendors and integrated by Harmonic into a system designed for monitoring and controlling Spectrum, ProBrowse, Harmonic MediaGrid, and MediaDeck systems. Contact Technical Support first for your support needs.

NSM-2016 and NSM-2016K Description

**NOTE:** The NSM-2016-C Platform is equivalent in form and function to the NSM-2016 Platform.

The NSM-2016 and NSM-2016K SystemManager Platforms are comprised of both hardware and software components:

- The SystemManager’s hardware platform is a 1 RU Windows 7 Platform that features an Intel Xeon microprocessor with 8 GB of memory and two integrated 10/100/1000 Mbps network interface controllers (NICs).
  - In addition, the NSM-2016K SystemManager Platform is packaged with a 17” USB KMM (keyboard, mouse, and monitor) with a combination video/USB cable providing keyboard and mouse functions. Refer to NSM-2016K SystemManager Platform Keyboard/Monitor Tray for more information.
- The following applications are factory-installed:
  - **SystemManager Application:** This is the software component that runs on the SystemManager Platform. The application communicates with a Spectrum, MediaGrid, or ProBrowse System over Ethernet, providing software update capability, network management, configuration, security, and fault monitoring services. The application also provides services such as DHCP and NTP. If you need to reinstall the application or upgrade to a later release, refer to Installing, Reinstalling, or Upgrading the SystemManager Application for step by step instructions.
  - **FLEXlm License Server:** Hands out licenses found in the license folder to the Harmonic SystemManager application and MediaTools. Refer to About the FLEXlm License Server for additional information.
  - **vDHCP (Spectrum and ProBrowse systems):** Used to auto configure IP addresses for units on a network.
  - **Microsoft Internet Explorer 7** browser.
  - **NTP for Windows (ProBrowse and Harmonic MediaGrid systems):** Ensures a common time reference across components in a ProBrowse and/or Harmonic MediaGrid system.
  - **Acrobat® Reader®:** Allows you to view PDF documents on the Platform.

Depending on your system, you may also need to install:
- **ClipTool**: Refer to “ClipTool Installation and Configuration” in the *Harmonic SystemManager User Guide* for detailed instructions.
- **ContentManager (Harmonic MediaGrid systems)**: Refer to the *Harmonic ContentManager User Guide* for detailed instructions.
- **WinFSD (Harmonic MediaGrid systems)**: Refer to the “Software Installation” section in the *Harmonic MediaGrid Installation and Configuration Guide* for detailed instructions.

**NOTE**: Harmonic does not support the installation of any other applications not mentioned above.

### NSM 2016/K Front Panel Components

*Figure 1–1* illustrates a typical front panel view of the SystemManager Platform with the front bezel removed.

![Figure 1–1: Front Panel of SystemManager Platform](image)

Following are descriptions of each front panel component as identified above.
<table>
<thead>
<tr>
<th>Key</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1   | Power on Indicator/Power Button  | The power-on indicator lights when the system power is on.  
The power button controls the DC power supply output to the system. When the system bezel is installed, the power button is not accessible.  
NOTE: When powering on the system, the video monitor can take from several seconds to over 2 minutes to display an image, depending on the amount of memory installed in the system.  
NOTE: On ACPI-compliant operating systems, turning off the system using the power button causes the system to perform a graceful shutdown before power to the system is turned off. |
| 2   | NMI Button                       | Used to troubleshoot software and device driver errors when using certain operating systems. This button can be pressed using the end of a paper clip.  
Use this button only if directed to do so by qualified support personnel or by the operating system’s documentation. |
| 3   | System Identification Button     | The system identification buttons on the front and back panels can be used to locate a particular system within a rack. When one of the buttons is pushed, the system status indicators on the front and back panels light blue until one of the buttons is pushed again. |
| 4   | Video Connector                  | Connects a monitor to the system.                                                                                                                                                                     |
| 5   | Diagnostic Indicator Lights      | The diagnostic indicator lights provide diagnostic information to help with troubleshooting. For details, see Table 1–2.                                                                                   |
| 6   | USB Connectors (2)               | Connects USB devices to the system. The ports are USB 2.0-compliant.                                                                                                                                   |
| 7   | System Identification Panel      | A slide-out panel for system information including the Express Service Tag, embedded NIC MAC address, and iDRAC6 Enterprise card MAC address. Space is provided for an additional label. |
Table 1–2: Diagnostic Indicator Lights

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Health indicator</td>
<td>If the system is on, and in good health, the indicator lights solid blue. The indicator blinks amber if the system is on or in standby, and any error exists (for example, a failed fan or hard drive).</td>
</tr>
<tr>
<td>Hard drive indicator</td>
<td>The indicator blinks green to indicate hard-drive activity.</td>
</tr>
<tr>
<td>Electrical indicator</td>
<td>The indicator blinks amber if the system experiences an electrical error (for example, voltage out of range, or a failed power supply or voltage regulator). See the system log or system messages for the specific issue. Re-seat the power supply by removing and reinstalling it.</td>
</tr>
</tbody>
</table>
| Temperature indicator | The indicator blinks amber if the system experiences a thermal error (for example, a temperature out of range or fan failure). Ensure that none of the following conditions exist:  
  - A cooling fan is removed or has failed.  
  - System cover, cooling shroud, EMI filler panel, memory-module blank, or back-filler bracket is removed.  
  - Ambient temperature is too high.  
  - External airflow is obstructed. |
| Memory indicator | The indicator flashes amber if a memory error occurs. Check the system event log or system messages for the location of the failed memory. Re-seat the memory module. |
| PCI indicator    | The indicator flashes amber if a PCIe card experiences an error. Restart the system. Update any required drivers for the PCIe card. Reinstall the card. |

NSM 2016/K Rear Panel Components

Figure 1–2 illustrates a typical rear panel view of the SystemManager Platform.
Figure 1–2: Rear Panel of SystemManager Platform

Following are descriptions of each rear panel component as identified above.

<table>
<thead>
<tr>
<th>Key</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Serial Connector</td>
<td>Connects a serial device to the system.</td>
</tr>
<tr>
<td>2</td>
<td>Video Connector</td>
<td>Connects a VGA display to the system.</td>
</tr>
<tr>
<td>3</td>
<td>System Identification Button</td>
<td>The system identification buttons on the front and back panels can be used to locate a particular system within a rack. When one of the buttons is pushed, the system status indicators on the front and back panels light blue until one of the buttons is pushed again.</td>
</tr>
<tr>
<td>4</td>
<td>System identification connector</td>
<td>Connects the system status indicator assembly through the cable management arm.</td>
</tr>
<tr>
<td>5</td>
<td>NIC Connector 1</td>
<td>Embedded 10/100/1000 NIC connector</td>
</tr>
<tr>
<td>6</td>
<td>NIC Connector 2</td>
<td>Embedded 10/100/1000 NIC connector.</td>
</tr>
<tr>
<td>7</td>
<td>USB Connectors (2)</td>
<td>Connects USB devices to the system. The ports are USB 2.0-compliant.</td>
</tr>
<tr>
<td>8</td>
<td>Power Supply</td>
<td>250 W AC power supply unit</td>
</tr>
<tr>
<td>9</td>
<td>Retention Clip</td>
<td>Secures the power cable.</td>
</tr>
</tbody>
</table>

NIC Indicator Codes

*Figure 1–3* illustrates the NIC indicators and the status of each.
The Keyboard/Monitor Tray is an integrated 1 RU chassis that includes a flat-panel LCD monitor, keyboard, and touchpad mouse. NSM-2016K SystemManager Platforms are packaged with a 17 inch monitor. The entire tray slides out for convenient storage and operation within the equipment rack and the adjustable monitor tilts-up into place for operation.

The following illustration shows the keyboard, monitor, and mouse unit which ships with the NSM-2016K SystemManager Platform.

**NOTE:** Always lay the monitor flat before unlocking the tray and re-inserting it into the rack. Damage to the LCD monitor may result if it remains upright when re-inserted into the rack.

For notes regarding legacy platforms, refer to the Appendix, *Legacy Platforms.*
## Figure 1–4: Keyboard / Monitor / Mouse Unit

<table>
<thead>
<tr>
<th>Key</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Rack rails</td>
<td>Two locking <strong>Rack Rails</strong> secure the Keyboard/Monitor Tray in your rack. Do not put additional weight on the tray when the Rack Rails are extended and the keyboard is in use.</td>
</tr>
<tr>
<td>2</td>
<td>Tilt-Up LCD Monitor</td>
<td>The <strong>Tilt-Up LCD Monitor</strong> provides the standard Windows user interface. The monitor is adjustable to the desired viewing angle.</td>
</tr>
<tr>
<td>3</td>
<td>LCD Monitor Controls</td>
<td>A set of <strong>LCD Monitor Controls</strong> (such as brightness, contrast, and power) is provided on the front of the Monitor case.</td>
</tr>
<tr>
<td>4</td>
<td>Keyboard</td>
<td>Provides function keys, keypad, and a <strong>TouchPad</strong> (in place of a mouse).</td>
</tr>
<tr>
<td>5</td>
<td>Keyboard/Monitor Tray</td>
<td>Houses all components and cable harnesses.</td>
</tr>
</tbody>
</table>

## Figure 1–5: Keyboard / Monitor Unit Back Panel
Following are descriptions of sections on the back panel of the Keyboard/Monitor unit as itemized above.

<table>
<thead>
<tr>
<th>Key</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Power On/Off Switch</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>AC IN</td>
<td>One AC IN connector is available on the unit.</td>
</tr>
<tr>
<td>3</td>
<td>Video Connector</td>
<td>- One 15-pin “D” connector (Video/Keyboard/Mouse) is provided for Keyboard,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Monitor and Mouse functionality. Connect the Video/USB cable here.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- On the NSM-2016 and NSM-2016/K, connections to the USB keyboard and mouse</td>
</tr>
<tr>
<td></td>
<td></td>
<td>from a single USB cable.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- On an NSM-2003, connections to the PS2 keyboard and mouse are split as</td>
</tr>
<tr>
<td></td>
<td></td>
<td>two cables.</td>
</tr>
</tbody>
</table>

**NSM–2016SW (Software–Only) SystemManager**

**System Requirements**

The NSM-2016SW is the software-only version of the SystemManager application for installation on a customer-supplied client computer with the following minimum hardware requirements:

- Windows Server 2008 R2 Service Pack 1, Windows 7 and Adobe Flash Player* installed on a client PC.
- Processor: 2 GHz or faster
- RAM requirements: 4 GB or more for Windows Server 2008 and Windows 7.
- Disk Space requirement is 150 MB baseline, plus 20 MB more per device being monitored.
- Monitor size at least 1024 x 768 (1280 x 1024 recommended)

**IMPORTANT:** A Microsoft SNMP Agent must be available on your computer for system monitoring and configuration purposes. If an SNMP Agent is not found by the SystemManager installer, a warning appears and you will be unable to continue with the installation process. Refer to [Installing a Windows SNMP Agent on SystemManager Client PCs](#) for installation instructions. To configure the SNMP service, refer to the Windows Help system. SystemManager will work with SNMP versions 1, 2c, and 3.

**Network Ports**

SystemManager requires that the following network ports be available on the computer on which it is installed:

- Port 80
- Port 8080
- Port 162
- Port 111
- Port 27000
Software and Documentation Packaging

Software updates are available from the Harmonic website. Contact Harmonic Technical Support for login information. The NSM-2016SW application consists of a number of applications and product documentation packaged as follows:

In SystemManager-v<releaseversion>-Software.exe:

- **SystemManager Application**: This application communicates with a Spectrum, Harmonic MediaGrid, ProBrowse, or MediaDeck system over Ethernet, providing software update capability, network management, configuration, security, and fault monitoring services.

  The following applications and services are packaged as part of the SystemManager application:

  - **FLEXlm License Server**: Hands out licenses found in the license folder for the Harmonic SystemManager and MediaTools. Refer to About the FLEXlm License Server for additional information.
  - **vDHCP** (Spectrum, MediaDeck, and ProBrowse systems): Used to auto configure IP addresses for units on a network.

  If you need to reinstall the application or upgrade to a later release, refer to Installing, Reinstalling, or Upgrading the SystemManager Application for step by step instructions.

- **Product documentation**, including:
  - Harmonic SystemManager User Guide
  - Harmonic SystemManager Online Help (.html files of the User Guide)

  The User Guide and Online Help are automatically installed to D:\OmneonDocs when you run the installer.

In SystemManager-v<releaseversion>-Documentation.exe:

- Harmonic SystemManager User Guide
- Harmonic SystemManager Release Notes
- Harmonic SystemManager Installation Guide (this guide).

Harmonic documentation is distributed in .PDF. Adobe Reader is required to view .PDF files. Acrobat Reader is available at www.adobe.com.
Chapter 2

SystemManager Platform Setup and Configuration

This chapter provides information about the SystemManager Platform setup and configuration. The following topics are covered:

- About SystemManager Platform or Client PC Network Setup and Configuration
- Setting Up the SystemManager Platform
- About Anti-Virus and Windows Updates
- About the FLEXlm License Server
- About the Web Browser

About SystemManager Platform or Client PC Network Setup and Configuration

Review the following notes before adding an NSM-2016 SystemManager Platform or a SystemManager client PC (client PC) to a network.

Network Setup

- Before adding a SystemManager Platform or client PC to a network, ensure network switches are in place, if needed.
- To avoid IP address conflicts when installing the SystemManager with an Harmonic MediaGrid system and running the Harmonic MediaGrid Configuration Assistant, please wait until after the Configuration Assistant is complete before assigning an IP address to the SystemManager. Note that this only applies when the SystemManager is placed within the same subnet as the Harmonic MediaGrid.
- The NSM-2016 SystemManager Platform is shipped with both network ports enabled as follows:
  - Port 1 = DHCP server (vDHCP) with a static IP address.
  - Port 2 = DHCP client.

**NOTE:** Change network and host settings according to your network requirements.

- Port 2 = DHCP client.

**NOTE:** If used, this port should be connected to a different IP network than that connected to Port 1. Before using vDHCP, configure static IP for the SystemManager Platform or client PC. In an Harmonic MediaGrid system, ensure that dual DHCP servers are working cooperatively so address conflicts are avoided. Refer to the **Harmonic MediaGrid Installation and Configuration Guide** for detailed instructions on DHCP configuration.

- For MediaDeck users, Harmonic recommends the use of the vDHCP service where the first port (NIC) on the SystemManager PC (platform or customer-supplied PC) has a static IP address. Refer to **About Installing vDHCP Server for Windows from the SystemManager Application Installer** for additional information.
- Follow these rules for port usage, according to the type of network the SystemManager will control:
Setting Up the SystemManager Platform

- For a Spectrum only, or a Spectrum and ProBrowse network, use the vDHCP port (Port 1) to connect to an IP network.
- For an Harmonic MediaGrid only network, configure the first port to be a DHCP client. Disable vDHCP and then connect Port 1 and Port 2 respectively to the switches for the A and B networks of an Harmonic MediaGrid.
- For an Harmonic MediaGrid and Spectrum network, use the vDHCP port (Port 1) to connect to an IP network. Add the Harmonic MediaGrid to the SystemManager managing the Spectrum network by connecting to a ContentDirector in the Harmonic MediaGrid system. Refer to “Connecting a Device from a Different IP Network” in the Harmonic SystemManager User Guide for instructions.

- Verify network connectivity of the SystemManager by pinging the gateway IP address.

Additional Configuration Options

- Configure the NTP service and modify vDHCP’s options to pass the time service IP address on to DHCP clients.
- If not in a Windows domain, you can set the time accurately, or configure NTP to get its time reference from some other trusted time source. In a Windows domain, the Domain Controller can provide this time source.
- In an Harmonic MediaGrid network, the time reference of the ContentDirectors should come from the SystemManager, or it should come from the same place where the SystemManager gets its time reference.
- If desired, add the SystemManager to a Windows Domain.
- For remote access by Technical Support, configure pcAnywhere. Refer to [http://www.symantec.com/index.jsp](http://www.symantec.com/index.jsp) for configuration information.

Setting Up the SystemManager Platform

Choose from the following topics:

- Unpacking and Inspection
- Installation Prerequisites
- Installation Block Diagram
- Installing and Powering up a SystemManager Platform
- Powering Down a SystemManager Platform
- SystemManager Platform Interconnection
- SystemManager Platform Documentation
Unpacking and Inspection

When you receive your SystemManager Platform components, inspect the shipping cartons for signs of physical damage. Contact your local Harmonic representative and the shipper immediately if you suspect any damage has occurred during shipping. Using the packing list, check the contents of each box to be sure that all parts are included. If any items are missing, contact your local Harmonic representative immediately.

**NOTE:** When inspecting the SystemManager Platform, note the service number on the service tag label located on the top of the unit or back of the units for newer models. You will need this number to access specific product information on the Dell web site.

Installation Prerequisites

When preparing to install the SystemManager, review the following prerequisites:

- **Environmental**

  The SystemManager Platform is designed to operate in normal “control room” conditions.

- **Power**

  Consult the Dell documentation CD which ships with the Platform for power requirements. When connecting each SystemManager, care must be taken to avoid power lines that are subject to noise and voltage spikes. Do not install the units on a power circuit that is common to such equipment as air conditioners and refrigeration units. An AC noise filter and surge protector are recommended if unstable power conditions are present.

- **Site**

  The Platform is a rack-mountable unit. Mounting holes on the front panel are set to RETMA standard spacing and will fit into any standard equipment rack with 4.45 cm (1.75 inches) of available vertical space per unit.

Installation Block Diagram

For reference in the following installation procedure, a simplified system block diagram is provided in *Figure 2–1*. Connector names are listed inside the main blocks.
Chapter 2 SystemManager Platform Setup and Configuration

Setting Up the SystemManager Platform

Figure 2–1: SystemManager Block Diagram

Installing and Powering up a SystemManager Platform

CAUTION: Please observe all static discharge precautions. Avoid handling the SystemManager Platform in high static environments such as carpeted areas and when synthetic fibre clothing is worn. Exercise proper grounding precautions at all times.

IMPORTANT: To provide optimum airflow, do not obstruct the unit’s air passages.

Complete installation instructions are provided with the SystemManager Platform documentation. Refer to SystemManager Platform Documentation for details.

To install and power up a SystemManager Platform:

1. Connect the Keyboard, Mouse (trackpad) and Monitor (KMM) cable to the Video connector on the rear panel of the Platform.

2. Plug in the single USB cable which controls the keyboard and trackpad.

NOTE: Harmonic does not recommend the use of a Keyboard, Monitor, Mouse (KMM) during initial deployment or setup.

3. Turn on the Power switch(es) on the KMM unit.

4. Turn on the Power switch on the front of the SystemManager Platform (behind the front bezel). If the green Power LEDs do not come on (on the front of the unit), re-check all power connections.

5. Ensure that the Windows operating system boots up properly. In the Welcome to Windows dialog, press CTRL + ALT + DEL to continue.

6. Review the EULA screen and click Approve.
7. Log in by typing “Administrator” as the user name and “omneon” as the password. Both entries are case sensitive. Press Enter to log on.

**NOTE:** Harmonic recommends you change the password from the default.

8. Modify the display resolution to 1280 x 1024 (recommended).

9. As necessary, double-click on the time in the lower right hand corner to access the **Date and Time Control** Panel and modify the time zone if required. The time zone is GMT by default.

10. If you have more than one SystemManager Platform in your facility (even on different IP networks), rename the unit via **System Properties > Computer Name > Computer Description**.

11. Adjust the IP setup according to your requirements. Refer to *About SystemManager Platform or Client PC Network Setup and Configuration* for rules on port usage.

This completes the installation and power-up procedure.

**Powering Down a SystemManager Platform**

**To power down a SystemManager Platform:**

1. On the SystemManager Platform, exit all Windows.
2. On the desktop, click **Start > Shutdown** to display the **Shut Down** dialog.
3. In the **Shut Down Windows** dialog, ensure that “**Shut down**” is selected in the drop-down box, then click **OK** to shut down the system. Before proceeding, make sure the computer has turned itself off.
4. Turn off the Power switch on your Monitor.
5. Turn off the Power switch on the SystemManager Platform.

This completes the power-down procedure.

**SystemManager Platform Interconnection**

- Refer to the **Spectrum System Installation Guide** for information on connecting to a Spectrum system.
- Refer to “System Overview and Installation” in the **Harmonic MediaGrid Installation and Configuration Guide** for information on connecting to an Harmonic MediaGrid.

**SystemManager Platform Documentation**

Full documentation for all SystemManager Platforms is shipped on a CD with each unit. In addition, the same documentation is available on-line. You can download platform documentation from the Dell website as follows:

1. Use your web browser to navigate to the Dell* website.
2. Search for the **Dell PowerEdge R230** page, and download the desired document(s).

**About Anti-Virus and Windows Updates**

The SystemManager Platform is shipped with Windows Firewall turned off and with notifications for Windows Firewall disabled. In most circumstances, Windows Firewall should not be turned back on. It must not be turned on if the Harmonic MediaGrid Windows FSD product will be installed as it blocks many services and can impact the normal operation and usage of SystemManager.
Windows Updates are also turned off and notifications are disabled. As there is no anti-virus package included in the SystemManager Platform software, notifications for “no anti-virus package” are also disabled. Harmonic recommends that customers install a basic anti-virus package to protect the system. Harmonic does not recommend installing larger anti-virus Internet security.

**About the FLEXlm License Server**

Macrovision's FLEXlm Manager is a Web-based software license management system that enables organizations to centrally track and manage license usage across an organization.

FLEXlm allows the SystemManager application, MediaTools, and Harmonic MediaGrid Application Processing (MGAP) functionality to acquire licenses to operate. It works by handing out licenses found in the license folder to each application or on a first-come-first-served basis. After all licenses are handed out, no more licenses are issued until an application or functionality is shut down and the license returned.

The FLEXlm License Server is factory-installed on the NSM-2016 and NSM-2016K. It is also installed as part of the SystemManager application installation for NSM-2016SW software-only configurations. License Files with a “.omlic” extension are emailed to customers by Harmonic on receipt of orders for applications and functionality managed by the License Server.

- Two licenses are required for a Primary and Secondary SystemManager setup; one for each SystemManager.
- Harmonic provides different types of License Files depending on the application or functionality:
  - **Demo**: Available for free and allows you to use a particular MediaTool for 7 days. (The License File has a “-d” in its name.) Provided only for MediaTools.
  - **Normal**: Granted by purchasing an application or functionality. The license is “floating” and allows the application or functionality to be used on any network attached PC. (The License File has a “-n” in its name.) Provided for all licensed applications and functionality.
  - **Upgrade**: Allows you to upgrade from an older version of an application or functionality to a newer version. (The License File has a “-u” in its name.) Provided for all licensed applications and functionality.

- Installing a license on the SystemManager Platform does not grant support for running the application on the Platform itself. The only applications which should be installed on the NSM-2016 SystemManager Platform are:
  - ClipTool (not ClipTool Pro)
  - Windows FSD
  - ContentManager (provided a license is available)

- Harmonic does not support the installation of any applications other than the SystemManager application itself on earlier models of the SystemManager Platform (NSM-2001, NSM-2003).

- Further information, including troubleshooting suggestions for FLEXlm can be found in the FLEXlm user manual available in the FLEXlm Start menu. For more information on the operation of the FLEXlm License Server, visit: [http://www.macrovision.com](http://www.macrovision.com).

Additional information relating to FLEXlm is available as follows:

- *Obtaining and Installing a SystemManager License File*
- *Configuring FLEXlm License Server Data Using the SystemManager*
About the Web Browser

The User Interface portion of SystemManager consists of a set of dynamic HTML pages which display in a web browser running on the SystemManager Platform, client PC, or on another system in the network. The SystemManager is qualified for use with Internet Explorer version 6.0 or later on Windows 2000, Windows XP, Windows 7, or Windows 8 depending on the SystemManager Platform model.

NOTE: With other web browsers, most of SystemManager's features are available and usable, though some drawing and alignment issues may occur. SystemManager's UI is not supported with web browsers that do not support compatible standards for DOM, Java script, and HTML.

The User Interface is displayed in a web browser that runs on any PC connected to the SystemManager via TCP/IP, usually over Ethernet. The web browser may also be run directly on the SystemManager. Windows 2008 Enterprise and Windows 7 are the supported operating systems for the server.

Refer to www.microsoft.com for installation information, user documentation, and technical support.
Installing, Reinstalling, or Upgrading the SystemManager Application

The SystemManager application (SystemManager) is factory-installed on Harmonic-supplied SystemManager Platforms, or is customer-installed on customer-supplied client PCs. Refer to NSM-2016SW (Software-Only) SystemManager for a list of the components which make up the application.

To install, reinstall, or upgrade the SystemManager application on a SystemManager Platform, or a client PC, review these procedures in the following order:

- Obtaining and Installing a SystemManager License File
- Installing, Reinstalling, or Upgrading SystemManager
- Installing Java Runtime Environment
- Configuring FLEXlm License Server Data Using the SystemManager
- Installing a Windows SNMP Agent on SystemManager Client PCs

Obtaining and Installing a SystemManager License File

You must have a valid License File managed by a FLEXlm License Server installed on the SystemManager Platform or client PC to run the SystemManager application.

For NSM-2016SW

For the software-only SystemManager (NSM-2016SW), the FLEXlm License Server is installed by default during the installation process. You must obtain and install the License File according to the following instructions:

To obtain the License File:
1. Identify the MAC address for the computer on which SystemManager will be installed:
a. Open a Command Prompt session, by clicking **Start > Run.** Type `cmd`, and then click **OK.**
b. From the Command Prompt, type `ipconfig/all`, and then press **Enter.**
c. Locate the numbers identified as the **Physical Address.** This is the MAC address. Note that there may be more than one.

2. Email your MAC address, sales order number (located on the packing list), and contact and mailing information to `zLicense@harmonicinc.com`.

3. Harmonic will send the license file to you via email. Save the attached file to your hard drive and create a backup copy of the license file in a safe place (for example, in a network file server backed up on a regular basis).

**To install a License File:**

1. Create a **Licenses** folder at the root level of the same drive on which you will install the SystemManager software (for example, `C:\Licenses` or `D:\Licenses`).
2. Copy the license file to the **Licenses** folder. When you install SystemManager, the installer will automatically locate the license file.

Once you have completed the installation, refer to *Configuring FLEXlm License Server Data Using the SystemManager* for detailed information on configuring the Server data.

**For NSM-2016/K**

NSM-2016/K SystemManager Platforms ship with the FLEXlm License Server installed; all you need to do is obtain a License File from Harmonic and install to the `D:\Licenses` directory on the unit. Depending on your order, the License File may already be installed on the unit.

To check if your unit already has a License File installed, go to the `C:\Licenses` or the `D:\Licenses` directory.

**NOTE:** `D:\ Licenses` is the default directory. The directory in which your license is installed may differ.

**Installing, Reinstalling, or Upgrading SystemManager**

Use the following steps to download and install, reinstall, or upgrade the SystemManager application.

**NOTE:** Before upgrading to the latest version of software, check with your automation, archival, and third party software vendors for compatibility information.

**NOTE:** If you are installing the Software-only SystemManager on your own client PC:

- You must have administrative privileges for the computer on which you plan to install SystemManager.
- A Microsoft SNMP Agent must be available on your computer for system monitoring and configuration purposes. If an SNMP Agent is not found by the SystemManager installer, a warning appears and you will be unable to continue with the installation process. Refer to *Installing a Windows SNMP Agent on SystemManager Client PCs* for installation instructions.

**NOTE:** Unless specifically noted, the instructions in this section apply to Windows 2008 and Windows 7. For Windows XP and Windows 2003, some steps may vary according to operating system.

**To install, reinstall, or upgrade SystemManager:**

1. Ensure that your SystemManager Platform or client PC is connected to the Internet.
2. Contact Harmonic Technical Support for login information to download software updates from the Harmonic website.
3. Locate and download the files for your system.

**SystemManager**
- SystemManager-v<version#>-Documentation.exe
- SystemManager-v<version#>-Software.exe
- jre-6-windows-i586.exe

Review *Installing Java Runtime Environment* for additional information.

**Spectrum**
The following files are available:
- Spectrum-v<version#>-Software.zip
- Spectrum-v<version#>-Documentation.exe
- HarmonicTemplatesAndTools-v<version#>-SWandDoc.exe

Review *Installing or Upgrading Spectrum Firmware* for additional information.

**ProBrowse**
The following files are available:
- ProBrowse-v<version#>-Software.exe
- ProBrowse-v<version#>-Documentation.exe

Harmonic recommends you do not download the ProBrowse system files unless you have a ProBrowse system and you wish to upgrade to the latest version.

Review *Installing or Upgrading ProBrowse Firmware* for additional information.

**Harmonic MediaGrid**
The following files are available:
- Harmonic-MediaGrid-v<version#>-Software.exe
- Harmonic-MediaGrid-v<version#>-Documentation.exe

**NOTE:** Harmonic recommends you do not download the Harmonic MediaGrid server files unless you have an Harmonic MediaGrid and you wish to upgrade to the latest version.

Review *Installing or Upgrading Harmonic MediaGrid Firmware* for installation information.

Review to the **Software Installation** chapter in the *Harmonic MediaGrid Installation and Configuration Guide* for client file system driver installation information.

**ProXchange**
The following files are available:
- ProXchange-v<version#>-Documentation.exe
- ProXchange-v<version#>-Software.exe
- ProXchange-v<version#>-Manager-Application.zip
Chapter 3 Software Installation

Installing, Reinstalling, or Upgrading the SystemManager Application

NOTE: Harmonic recommends you do not download the ProXchange system files unless you have a ProXchange system and you wish to upgrade to the latest version. Review *Installing or Upgrading ProXchange Firmware* for additional information.

Media Application Server (MAS)

The following files are available:

- MAS-v<version#>-Documentation.exe
- MAS-v<version#>-Software.exe

NOTE: Harmonic recommends you do not download the MAS system files unless you have an MAS system and you wish to upgrade to the latest version. Review *Installing or Upgrading MAS Firmware* for additional information.

4. Download the required files:
   a. Right-click on the specific file(s) that you want to download. For each release, you should download the both the release file and the documentation files.
   b. Choose “Save Target As,” and then select a directory in which to save the file.

5. On your SystemManager Platform or client PC, exit all Windows programs at this point, particularly any Harmonic utilities. Do one of the following:
   a. If you are installing the SystemManager application for the first time on a system with Windows 2008 or Windows 7, go to step 7.
   b. If you are reinstalling or upgrading from a version of SystemManager, continue to the next step.

6. For upgrades, remove the existing SystemManager application by clicking Start > Settings > Control Panel and then double-clicking Add/Remove Programs.
   - When the Add/Remove Programs dialog box appears:
     a. Click Change or Remove Programs and select Omneon Manager from the Installed Programs column.
     b. Click Change/Remove.
     c. Click Yes to confirm the removal of the SystemManager application.
     d. Click OK to exit the Add/Remove Programs dialog box.
     e. Reboot the SystemManager Platform or client PC to ensure the old version is completely uninstalled.

7. Verify that the Windows SNMP agent is installed and running. An SNMP Agent must be available on your client PC for system monitoring and configuration purposes. Note that SystemManager Platforms ship with SNMP Agents already installed.

   **To verify that the SNMP Service is running:**
   a. Open the Windows Services dialog box by clicking Start > Control Panel > Administrative Tools > Services.
   b. Locate SNMP Service and verify that the Status is set to Started and the Startup Type is set to Automatic. If necessary, double click SNMP Service to modify its properties.
   c. Locate SNMP Trap and verify that the Status is not Started and that the Startup Type is set to Manual or Disabled. If necessary, double click SNMP Trap Service to stop the service.
For instructions on installing the SNMP Agent, refer to Installing a Windows SNMP Agent on SystemManager Client PCs.

8. Navigate to the directory into which you downloaded the release files and double-click SystemManager-v<version#>-Software.exe to commence installation. An InstallShield wizard appears.

9. Click Setup to proceed to the Welcome dialog box.

10. Click Next to proceed to the Computer System Requirements dialog box.

11. Once you review the requirements, click Yes to display the License Agreement.

12. Read the License Agreement thoroughly, and then click Yes to display the Customer Information dialog box.

13. Enter User Name and Company Name in the appropriate fields.

14. Click Next to display the Choose Destination dialog box.

The default destination is D:\Omneon if a D drive exists. Otherwise, the default directory is C. Leave the default destination directory at D:\Omneon (recommended) or click Browse and select a different destination.
15. Click **Next** to display the **Select Features** dialog box.

Note the following important points:

- If you are installing a Spectrum system and do not have a DHCP server on your network, Harmonic recommends that you install vDHCP so IP addresses can be automatically configured on your network.
- For Windows 2008 or Windows 7, if vDHCP is already installed, leave vDHCP unchecked so it does not attempt to re-install.
- If you have an existing installation in which a SystemManager Platform or a client PC manages ProBrowse, Harmonic MediaGrid, or Spectrum systems, accept the default settings.
If you have a new installation with ProBrowse systems, you must install vDHCP and then configure it afterwards, and enable NTP. For Windows 2008 and Windows 7, refer to your operating system Help for instructions on configuring NTP.

If you have a new installation with Harmonic MediaGrid systems, do not install vDHCP.

**NOTE:** If you intend to install vDHCP, Harmonic recommends you unplug the network cable attached to the SystemManager Platform or client PC. Failure to unplug the cable could result in network problems as the vDHCP service will be running before the service is configured. Once the SystemManager installation process is completed, you can reattach the network cable and configure vDHCP.

16. Click **Next** to display the **Review Settings** dialog box.

![Figure 3–4: Start Copying Files Dialog](image)

17. Click **Next** to begin copying the files. After a few moments, the **InstallShield Status** dialog box opens and begins to copying your files.

### Installing FLEXlm

**To install FLEXlm:**

1. As the files are being copied, the **Setup Status** dialog box appears, followed by the FLEXlm **Welcome** dialog box.

   **NOTE:** Starting with the SystemManager 5.4 release, a FLEXlm License Server is needed to hand out licenses for running the SystemManager application. Harmonic recommends using the same MAC address (same unit) for running the License Server and the SystemManager application.

2. Follow the on-screen recommendations for installing FLEXlm and then click **Next** to display the **License Agreement**.
3. Read the License Agreement thoroughly, and then click **Yes** to display the **Information** dialog box.
4. Click **Next** to display the **Choose Destination** dialog box where the FLEXlm License Server gets installed. Leave the default destination directory at C:\Program Files\FLEXlm (recommended) or click **Browse** and select a different destination.
Figure 3–5: Choose Destination Location Dialog for FLEXlm License Server

5. Click **Next** to display the **Choose License File Folder** dialog box. Make sure the path shown under **Destination Folder** matches the location of the **Licenses** folder you created when you obtained the License File (see *Obtaining and Installing a SystemManager License File*).

![Choose License File Folder](image)

Figure 3–6: Choose License Folder Dialog

**NOTE:** If the D:\Licenses folder does not exist, or it is not a writable drive, click **Browse** to select an alternate location.
6. Click **Next** to display the **Select Program Folder** dialog box. Leave the default Program Folder as is, or select one from the existing Folders List.

![Figure 3–7: Select Program Folder Dialog](image)

7. Click **Next** to display the **(FLEXlm) Start Copying Files** dialog box.

![Figure 3–8: Start Copying Files Dialog](image)

8. Click **Next** to proceed to the **Setup Complete** dialog box.
9. Review the Readme.txt file and then click **Finish**.

**Installing Java Runtime Environment**

Java Runtime Environment (JRE) is required for some SystemManager and Harmonic MediaGrid switch functionality.

**To install the required JRE:**

1. From the SystemManager software download package, double-click on the file: **jre-6-windows-i586.exe**.
2. Follow the on-screen instructions to complete the **typical** installation.

**Configuring FLEXlm License Server Data Using the SystemManager**

Once you have installed a valid License File on the SystemManager Platform or client PC, you must configure the License Server Data.

**To configure the License Server Data:**

1. Start the License Server as follows:
   a. In Windows, choose **Start > All Programs > FLEXlm > LM Tools**.
      
      The **License Manager Tools** utility launches.
   b. Click the **Start/Stop/Reread** tab.
c. Click the **Start Server** button.

d. Click the **X** button to close the **LM Tools** window.

2. Ensure the FLEXlm Service is running as follows:
   a. In Windows, choose **Start > Control Panel > Administrative Tools > Services**.
   b. Under **Name**, double-click **FLEXlm License Manager**.
c. In the **Startup Type** menu, ensure **Automatic** is selected.
d. Ensure that the **Service Status** is **Started**.
e. Click **OK**.

3. Log on to the SystemManager application (refer to *Logging on to SystemManager*) and navigate to the **Home > Options**.

4. In the **FLEXlm License Server Data** section, enter the IP address for the SystemManager unit where the valid License File is installed.

**NOTE:** If the license is on the local SystemManager, you can launch the SystemManager from that PC and enter *localhost* in the server data field.

![Options](image)

**Figure 3–13: FLEXlm License Server Data Options**

5. Click **Update**. If a valid License File is found at the specified location, the SystemManager GUI becomes fully usable. The IP address is saved as the default License Server for future SystemManager sessions.

Refer to *About the FLEXlm License Server* for general information about using FLEXlm for licensing Harmonic products.

### Installing a Windows SNMP Agent on SystemManager Client PCs

**NOTE:** The following instructions apply to Windows 2008 and Windows 7. For Windows XP and Windows 2003, some steps may vary according to operating system.

Follow these steps to install a Windows SNMP Agent on a SystemManager client PC. Note that SystemManager will work with SNMP versions 1, 2c, and 3.

**NOTE:** The SNMP agent comes pre-installed on the SystemManager Platforms provided by Harmonic. If you are using a SystemManager Platform, do not perform the following steps unless you are re-installing the SNMP agent.

To **install a Windows SNMP agent**:

1. Login as Administrator, or as a user account that has been given administrative permissions on the SystemManager client PC.
2. In Windows, click **Start > Control Panel > Programs and Features**.
3. Click **Turn features on or off**. The Server Manager dialog box appears, as shown in *Figure 3–14*.
Figure 3–14: Server Manager Dialog Box

4. Click **Add Features**. The Add Features Wizard appears, as shown in Figure 3–15.

Figure 3–15: Add Wizards Dialog Box

5. Select **SNP Services**, and click **Next**. The **Confirm Installation Selections** dialog box will appear, as shown in Figure 3–16.
6. Click **Install**.

**About Installing vDHCP Server for Windows from the SystemManager Application Installer**

vDHCP is a DHCP (Dynamic Host Configuration Protocol) server for Windows, and is included in the SystemManager installer as an optional component.

If you already have a working DHCP service installed on either a SystemManager platform or another device in your subnet, Harmonic recommends that you do not install vDHCP from the SystemManager installer.

If you do select to install vDHCP during the SystemManager application installation process, the following occurs:

**NOTE:** if vDHCP is already installed, do not attempt to re-install it. Attempting to do so will result in problems with the SystemManager installation.

- If vDHCP is not already installed on the SystemManager Platform or client PC, vDHCP will be installed, the service will commence briefly and then be disabled once the SystemManager application installation process is completed.

**Logging on to SystemManager**

This section provides instructions for logging on to the SystemManager application using Internet Explorer browser. Use this procedure to access the SystemManager and control Harmonic devices from both local and remote computers. The SystemManager application does not have to be installed on the local or remote PC in order to log in.
NOTE: A valid license is required to operate the SystemManager application on either a SystemManager Platform or a customer-supplied PC. Refer to *Obtaining and Installing a SystemManager License File* for detailed instructions on obtaining and installing a license file for use on the SystemManager hardware. You should have already installed the license file before logging on to the SystemManager application.

**To log on to SystemManager:**

1. From your desktop, SystemManager Platform, or client PC, double click the **Internet Explorer** icon to launch Internet Explorer.

2. If the **SystemManager Logon** page does not appear automatically, there are two different ways to log in, depending upon the computer’s location:
   a. For the SystemManager Platform or client PC itself, in the address bar type:
      
      http://localhost/
   
   b. For any other PC, in the address bar type the name (or IP address) of the SystemManager Platform or client PC. This name (or address) can be obtained from your system administrator. For example:
      
      http://Managerpc/

3. Press **Enter**. The **SystemManager Logon** page appears.

![SystemManager Logon](image)

**Figure 3–17: SystemManager Logon**

Depending on the security settings for your Internet browser, you may see the following message when the Logon page appears.

![Logon Information Bar](image)

**Figure 3–18: Logon Information Bar**
Click Close. Then right-click in the Information Bar and, unless you wish to enable intranet settings, select Don’t Show Me this Again.

4. Click the Login button to display the Enter Network Password dialog box.
   a. Enter the User Name: Administrator
   b. Enter the password (case sensitive): omneon

5. Click OK to display the Configuration tab. The System Diagram page displays by default. Refer to the Harmonic SystemManager User Guide for information on viewing your system components.

Installing or Upgrading Spectrum Firmware

To install or upgrade Spectrum firmware:

1. Contact Harmonic Technical Support for login information to download software updates from the Harmonic website.
2. Double-click on Spectrum-v<version#>-Software.zip to install to the D:/Upgrades directory on the SystemManager Platform or your client PC.

Upgrade Spectrum system components via the SystemManager application. Refer to the “Upgrade Firmware” section in the Spectrum System Installation Guide for step by step instructions.

Installing or Upgrading ProBrowse Firmware

To install or upgrade ProBrowse firmware:

1. Contact Harmonic Technical Support for login information to download software updates from the Harmonic website.
2. Install the ProBrowse firmware and Dell OpenManage files on the ProBrowse Server.
   Refer to the “ProBrowse Server and Dell OpenManage Software Installation” in the ProBrowse Installation and User Guide for step by step instructions.

Installing or Upgrading Harmonic MediaGrid Firmware

For Harmonic MediaGrid systems, installing or upgrading firmware for system components, such as ContentServers, is done via the SystemManager application and the SystemManager Platform or client PC.

To install or upgrade to a new version of Harmonic MediaGrid firmware:

1. Contact Harmonic Technical Support for login information to download software updates from the Harmonic website.
2. Download the Harmonic-MediaGrid-v<version#>-Software.exe file to the SystemManager Platform.
3. Double-click the downloaded file.
4. Click Yes to accept the End User License Agreement.
The files unpack into the \D:\OmneonUpgrades directory on the SystemManager Platform or client PC. These files are ready for use by SystemManager. The next step is to upgrade Harmonic MediaGrid System components via the SystemManager application. Refer to “Upgrading Harmonic MediaGrid Firmware” in the Harmonic SystemManager User Guide for step by step instructions.

Installing or Upgrading ProXchange Firmware

To install or upgrade to a new version of ProXchange firmware:
1. Contact Harmonic Technical Support for login information to download software updates from the Harmonic website.
2. Download ProXchange-v<version#>-Software.exe to the SystemManager Platform or client PC.
3. Double-click on the downloaded file to install to the D:/Upgrades directory on the SystemManager Platform or your client PC.
4. Click Yes to accept the End User License Agreement.

Installing or Upgrading MAS Firmware

The Pro Application Suite for MAS does not need to be installed, as it is a web-based interface. Launch the service by pointing the browser to the MAS server: http://<server IP address>/

For detailed set up instructions, refer to “System Set Up and Configuration” in the MAS Installation and Configuration Guide.

Upgrade instructions for the MAS system vary depending on whether you are using a standalone or high availability configuration. For detailed instructions, refer to “Software Upgrade and Reinstallation” in the MAS Installation and Configuration Guide.

Reinstalling the SystemManager Platform Operating System on NSM–2016 or NSM–2016K

Harmonic provides an ISO image for the SystemManager Platform operating system for the purpose of system recovery. The NSM-2016 and NSM-2016K SystemManager Platform image contains Windows 7 and additional software for managing Harmonic components.

CAUTION: The SystemManager Platform ISO image is intended for use only if the SystemManager Platform’s operating system needs to be reinstalled on certified authentic hardware, for example, after a hard disk failure or a corrupt operating system configuration. Do not attempt to install the ISO image or any other Harmonic-supplied installation DVD without first contacting Technical Support for assistance. Installing an incorrect ISO image or DVD to your hardware configuration will cause problems with the system.

To reinstall the operating system, first download the ISO image to an empty USB flash drive, and then boot from the flash drive to reformat the SystemManager Platform hard drive and reinstall the operating system. Before you begin, make sure you have:

- Internet access
Reinstalling the SystemManager Platform Operating System on NSM-2016 or NSM-2016K

Chapter 3 Software Installation

An empty USB flash drive with at least 6 GB of space

**IMPORTANT:** The Dell R210 II ISO image must only be used with Dell R210 IIIs. Likewise, the recovery DVDs for other models must only be used with those respective models.

To create a USB flash drive with the ISO image:
1. Download the latest ISO image provided by the Harmonic support team.
   - FTP Site: ftp.harmonicinc.com
   - User: sysman
   - Password: recovery
   - Folder: SystemManager
2. In Windows 7, create a working directory in windows explorer, and unzip the USBTools.zip file to this folder.
3. Locate and move the ISO file to the working directory at the same level as the USBTools unzipped directory.
4. Insert an empty USB flash drive. All the existing data will be deleted on the flash drive.
5. Right-click the `CreateUSBImage.bat` file in Windows explorer to run as administrator.
6. When the popup window appears, select the USB drive letter to boot from. Note the entries are case-sensitive.
7. Click Enter.
8. Type Y (in capital letter) to proceed with the copying. After confirmation, the process takes approximately 30 minutes. The image file size is approximately 6 GB.
9. After the process is completed, unplug the USB drive.
10. Continue to the next procedure to use this USB drive to install the ISO image.

Use the USB flash drive to reinstall the operating system:
1. Make sure the SystemManager Platform is powered down and then insert the USB flash drive that contains the ISO image.
2. Power up the system.
3. Click F11 to view the BIOS Boot Manager menu.
4. In the Boot Manager, select **Hard Drive C:**
5. In the sub-menu, select the USB flash drive. Note the message: “The hard disk will be reformatted. Are you sure you want to continue?”

**CAUTION:** Upgrading the operating system with the recovery media will erase all data on your local machine.

6. Click Yes to continue. A second message displays: “All the data on the hard disk will be deleted. Please backup you data before continuing. Are you sure you want to continue?”
7. Click Yes to continue after you have made a backup of the current catalog onto an external storage device.
   The upgrade process takes approximately 15 minutes.
8. After the system automatically reboots, remove the USB flash drive from the slot.
9. Log on to Windows. User is **Administrator.** Password is **omneon.”**
NOTE: It may take up to two minutes before the keyboard can be used after reboot.

10. You may be prompted with a “Systems Settings Change” box, alerting you that system settings have changed and asking if you want to restart your computer for these changes to take effect. Select Yes to restart the computer.


12. Reinstall all Harmonic applications including SystemManager. Refer to Installing, Reinstalling, or Upgrading the SystemManager Application for instructions.


Synchronizing Clocks on Spectrum Video Servers and the SystemManager Platforms or Client PCs

Each Spectrum Video Server host maintains a time-of-day clock that is used to generate timestamps on files and log messages. This clock is different from the video reference signal connected to the Spectrum Video Server’s reference connector. These time-of-day clocks may drift in relation to each other if they are not synchronized to a central source.

The following procedure may be used for clock synchronization purposes. Once synchronized, the time-of-day clocks on all Harmonic products will keep time stamps consistent. This is recommended practice for any Harmonic installation, but particularly important in an EFS SystemManager Platform. This procedure also configures the vDHCP server to grant leases to the Spectrum Video Server to expect NTP service from the SystemManager Platform.

Synchronizing Clocks on the NSM–2016 or NSM–2016SW Installed on a Client PC

To synchronize clocks:

1. Configure the Windows Time service in Windows to use an internal hardware clock and an external time source. For Windows 7, refer to Configuring NTP on Windows 7.
2. Add an entry to vDHCP so that MediaDirectors are instructed to get time from the SystemManager’s NTP server.
3. Open the vDHCP application.
4. Highlight existing leases one at a time, and verify that they will not expire in the next few minutes while completing steps 12 through 16. Unless lease duration has been previously changed to a very short time from the factory default, this should not be an issue, as leases are normally renewed halfway through the lease duration as configured in the General tab.
5. Close vDHCP if it is currently running (make sure you shut down the whole program, not just the settings window, best done by stopping the service in Windows Services).
6. Open the VDHCP.INI file in C:\Program Files\vdhcp by using a text editor (e.g., Notepad).
7. Add the following lines to the end of the file (unless they already exist in the file; all options should be together under one Options entry). This example assumes the client PC on which the SystemManager is installed has an IP address of 172.16.1.10 (please substitute the actual IP address):

```
[OPTIONS]
MaxOptions=100
Option42=I172.16.1.10
```
8. Save and close the **VDHCP.INI** file.
9. Restart vDHCP in **Windows Services**.
10. Check and set the client PC’s date and time clock to the correct time (lower right corner of the desktop).
11. Reboot the MediaDirector(s) to get new DHCP leases for each host. The leases should now include the client PC’s IP address as an NTP server; this may be verified in the MediaDirector(s) monitor log following the reboot.

The MediaDirector hosts will update their time-of-day clocks from the client PC’s clock periodically (currently, this period is every 11 minutes).

**Configuring NTP on Windows 7**

To configure the NTP settings on Windows 7, use the Local Group Policy Editor in Windows.

1. To open the Local Group Policy Editor, click **Start**, type `gpedit.msc` in the **Start Search** box, and then press **ENTER**.
2. From the left-hand column, click **Administrative Templates > System > Windows Time Service > Time Providers** as shown in Figure 3–19.

![Figure 3–19: Local Group Policy Editor](image)

3. Enable the Windows NTP client.
   a. Double-click **Enable Windows NTP Client**.
   b. From the Enable Windows NTP Server dialog, select **Enabled**, and then click **OK**.
4. Enable the Windows NTP server.
   a. Double-click **Enable Windows NTP Server**.
   b. From the Enable Windows NTP Server dialog, select **Enabled**, and then click **OK**.
5. Configure the Windows NTP client.
   a. Double-click **Configure Windows NTP Client**.
   b. From the Configure Windows NTP Client dialog, select **Enabled**, and then enter a value for your NTP Server in the **NtpServer** field, as described in the adjacent Help window.
   c. From the Type drop-down menu, select **NTP**. Note that NTP is not the default option. Click **OK**.
Figure 3–20: Configure Windows NTP Client

6. Verify that the Local Group Policy Editor shows all three NTP settings are Enabled, as shown in Figure 3–21.

Figure 3–21: Local Group Policy Editor with NTP Settings Enabled

7. Verify that the Windows Time service is started.
   a. Click the Start button, type services.msc in the Search box, and then press ENTER.
   b. In the Services dialog, scroll down to Windows Time.
   c. Verify the status is Started. If the status shows Stopped, double-click Windows Time, set the Startup type to Automatic, click Start, and then click OK. See Figure 3–22.
Accessing Documentation for a Release

Harmonic provides extensive technical documentation.

There are three ways to find documentation for a release:

- **Accessing Documentation from the Windows Start Menu** (SystemManager Documentation only)
- **Downloading the Latest Documentation from Harmonic**
- **Locating the Latest Documentation on the Harmonic Website**

Accessing Documentation from the Windows Start Menu

During the installation of the SystemManager software, the latest versions of the Harmonic SystemManager User Guide and Online Help system are installed for access via the Start menu. Click **Start > Programs > Omneon** to find documents in this suite.

Downloading the Latest Documentation from Harmonic

We highly recommend you download and review the latest documentation made available for each release. In particular, you should always review product Release Notes as they contain important last minute information not documented elsewhere.

To download the latest documentation:

1. Contact Harmonic Technical Support for login information to download software updates from the Harmonic website.
2. Download `SystemManager-v<version#>-Documentation.exe`.
4. If you have a D: drive that is writeable, keep the default destination directory of “D:\OmneonDocs”. If not, change the destination to “C:\OmneonDocs”. Click **Unzip**.
5. Files will now be extracted to the directory and a summary result dialog box will show “<n> files unzipped successfully”. Click **OK**.
6. An explorer window will be opened to show the files.
The SystemManager Help is an online format of the User Guide. To access the Help from the SystemManager application, click the Help tab, and then click the icon for Launch Online Help from the left-hand column.

### Locating the Latest Documentation on the Harmonic Website

The latest product documentation, as well as information provided for older releases, is available on the Harmonic website at: [http://www.harmonicinc.com/documents-detail](http://www.harmonicinc.com/documents-detail).
Appendix A
Legacy Platforms

The following sections contain information about the legacy SystemManager platforms. The following topics are covered:

- **Overview**
- **NSM-2012 and NSM-2012K SystemManager Platform**
- **NSM-2012K SystemManager Platform Keyboard/Monitor Tray**

### Overview

The following table describes the legacy SystemManager platforms.

<table>
<thead>
<tr>
<th>Table 3–1: Platform Configurations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Model</strong></td>
</tr>
<tr>
<td>-----------</td>
</tr>
</tbody>
</table>
| NSM-2001  | - Dell™ PowerEdge™ 350, 450, 550, 560, or 850  
- Intel® Celeron® processor or older processor  
- 256 MB to 512 MB depending on Dell model | - Windows 2000 Pro SP 4 or earlier version  
- SystemManager Application  
- Symantec pcAnywhere  
- FLEXlm License Server  
- vDHCP  
- Microsoft Internet Explorer 6  
- NTP for Windows  
- PuTTY |
| NSM-2003  | - Dell™ PowerEdge™ 350, 450, 550, 560, or 850  
- Intel® Celeron® processor or older processor  
- 256 MB to 512 MB depending on Dell model  
- Tray with keyboard  
- Mouse  
- 15-inch LCD monitor  
- PS/2 connector cable | - Windows 2000 Pro SP 4 or earlier version  
- SystemManager Application  
- Symantec pcAnywhere  
- FLEXlm License Server  
- vDHCP  
- Microsoft Internet Explorer 6  
- NTP for Windows  
- PuTTY |
Appendix A Legacy Platforms

NSM-2012 and NSM-2012K SystemManager Platform

Choose from the following topics:

- **NSM-2012 and NSM-2012K Description**
- **NSM 2012/K Front Panel Components**
- **NSM 2012/K Rear Panel Components**

**NOTE:** The SystemManager Platform consists of hardware and software components provided by other vendors and integrated by Harmonic into a system designed for monitoring and controlling Spectrum, ProBrowse, Harmonic MediaGrid, and MediaDeck systems. Contact Technical Support first for your support needs.

### NSM-2012 and NSM-2012K SystemManager Platform

<table>
<thead>
<tr>
<th>Model</th>
<th>Hardware</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>NSM-2007</td>
<td>- Dell™ PowerEdge™ 860, or R200</td>
<td>- Windows XP Embedded Platform</td>
</tr>
<tr>
<td></td>
<td>- Intel® Celeron® Processor 430 at 1.8 GHz, 12K Cache, 800 MHz FSB</td>
<td>- SystemManager Application</td>
</tr>
<tr>
<td></td>
<td>- or higher performance</td>
<td>- Symantec pcAnywhere</td>
</tr>
<tr>
<td></td>
<td>- 1GB RAM</td>
<td>- FLEXlm License Server</td>
</tr>
<tr>
<td></td>
<td>- 1 GB of DDR2 memory</td>
<td>- vDHCP (Spectrum and ProBrowse systems)</td>
</tr>
<tr>
<td></td>
<td>- Two integrated 10/100/1000 Mbps network interface controllers (NICs)</td>
<td>- Microsoft Internet Explorer 7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- NTP for Windows</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- PuTTY</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Adobe® Reader®</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Model</th>
<th>Hardware</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>NSM-2012/NSM-2012-</td>
<td>- Dell* PowerEdge* R210 II</td>
<td>- Windows 7 Enterprise</td>
</tr>
<tr>
<td>C</td>
<td>- Intel* Xeon E3-1240 series processor 3.30 GHz, 8M Cache</td>
<td>- SystemManager Application</td>
</tr>
<tr>
<td></td>
<td>- 8 GB Memory (2x4 GB)</td>
<td>- FLEXlm License Server</td>
</tr>
<tr>
<td></td>
<td>- 500 GB 7200 rpm SATA Hard disk</td>
<td>- vDHCP (Spectrum and ProBrowse systems)</td>
</tr>
<tr>
<td></td>
<td>- Two integrated 10/100/1000 Mbps network interface controllers (NICs)</td>
<td>- Microsoft Internet Explorer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- NTP for Windows</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Adobe® Reader®</td>
</tr>
</tbody>
</table>

**NSM-2012 and NSM-2012K Description**

**NOTE:** The NSM-2012-C Platform is equivalent in form and function to the NSM-2012 Platform.

The NSM-2012 and NSM-2012K SystemManager Platforms are comprised of both hardware and software components:

- The SystemManager’s hardware platform is a 1 RU Windows 7 Platform that features an Intel Xeon microprocessor with 8 GB of memory and two integrated 10/100/1000 Mbps network interface controllers (NICs).
  - In addition, the NSM-2012K SystemManager Platform is packaged with a 17” USB KMM (keyboard, mouse, and monitor) with a combination video/USB cable providing keyboard and mouse functions. Refer to *NSM-2012K SystemManager Platform Keyboard/Monitor Tray* for more information.
- The following applications are factory-installed:

© 2016 Harmonic Inc. All rights reserved. 56 SystemManager Release 6.4
SystemManager Application: This is the software component that runs on the SystemManager Platform. The application communicates with a Spectrum, MediaGrid, or ProBrowse System over Ethernet, providing software update capability, network management, configuration, security, and fault monitoring services. The application also provides services such as DHCP and NTP. If you need to reinstall the application or upgrade to a later release, refer to Installing, Reinstalling, or Upgrading the SystemManager Application for step by step instructions.

FLEXlm License Server: Hands out licenses found in the license folder to the Harmonic SystemManager application and MediaTools. Refer to About the FLEXlm License Server for additional information.

vDHCP (Spectrum and ProBrowse systems): Used to auto configure IP addresses for units on a network.

Microsoft Internet Explorer 7 browser.

NTP for Windows (ProBrowse and Harmonic MediaGrid systems): Ensures a common time reference across components in a ProBrowse and/or Harmonic MediaGrid system.

Acrobat® Reader®: Allows you to view PDF documents on the Platform.

Depending on your system, you may also need to install:

- ContentManager (Harmonic MediaGrid systems): Refer to the Harmonic ContentManager User Guide for detailed instructions.
- WinFSD (Harmonic MediaGrid systems): Refer to the “Software Installation” section in the Harmonic MediaGrid Installation and Configuration Guide for detailed instructions.

NOTE: Harmonic does not support the installation of any other applications not mentioned above.

NSM 2012/K Front Panel Components

Figure 3–23 illustrates a typical front panel view of the SystemManager Platform with the front bezel removed.

![Front Panel Diagram](image.png)

Figure 3–23: Front Panel of SystemManager Platform

Following are descriptions of each front panel component as identified above:
### Table 3–2: Front Panel Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power on Indicator/Power Button</td>
<td>The power-on indicator lights when the system power is on. The power button controls the DC power supply output to the system. When the system bezel is installed, the power button is not accessible.</td>
</tr>
<tr>
<td></td>
<td>NOTE: When powering on the system, the video monitor can take from several seconds to over 2 minutes to display an image, depending on the amount of memory installed in the system.</td>
</tr>
<tr>
<td></td>
<td>NOTE: On ACPI-compliant operating systems, turning off the system using the power button causes the system to perform a graceful shutdown before power to the system is turned off.</td>
</tr>
<tr>
<td>NMI Button</td>
<td>Used to troubleshoot software and device driver errors when using certain operating systems. This button can be pressed using the end of a paper clip.</td>
</tr>
<tr>
<td></td>
<td>Use this button only if directed to do so by qualified support personnel or by the operating system's documentation.</td>
</tr>
<tr>
<td>Video Connector</td>
<td>Connects a monitor to the system.</td>
</tr>
<tr>
<td>Hard Drive Activity Indicator</td>
<td>Lights up when the hard drive is in use.</td>
</tr>
<tr>
<td>Diagnostic Indicator Lights (4)</td>
<td>The four diagnostic indicator lights display error codes during system startup. Refer to <a href="#">Diagnostic Indicator Codes</a>.</td>
</tr>
<tr>
<td>System Status Indicator</td>
<td>■ Lights blue during normal system operation.</td>
</tr>
<tr>
<td></td>
<td>■ Lights amber when the system needs attention due to a problem.</td>
</tr>
<tr>
<td>System Identification Button</td>
<td>The system identification buttons on the front and back panels can be used to locate a particular system within a rack. When one of the buttons is pushed, the system status indicators on the front and back panels light blue until one of the buttons is pushed again.</td>
</tr>
<tr>
<td>USB Connectors (2)</td>
<td>Connects USB devices to the system. The ports are USB 2.0-compliant.</td>
</tr>
</tbody>
</table>
## Diagnostic Indicator Codes

The four diagnostic indicator lights on the system front panel display error codes during system startup. Lists the causes and possible corrective actions associated with these codes. A highlighted circle indicates the light is on; a non-highlighted circle indicates the light is off.


### Table 3–3: Diagnostic Indicator Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Causes</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Code" /></td>
<td>The system is in a normal off condition or a possible pre-BIOS failure has occurred. The diagnostic lights are not lit after the system successfully boots to the operating system.</td>
<td>Plug the system into a working electrical outlet and press the power button.</td>
</tr>
<tr>
<td><img src="image" alt="Code" /></td>
<td>The system is in a normal operating condition after POST.</td>
<td>Information only.</td>
</tr>
<tr>
<td><img src="image" alt="Code" /></td>
<td>BIOS checksum failure detected; system is in recovery mode.</td>
<td>Refer to “Getting Help” in the <em>Dell PowerEdge R210 II Systems Owner’s Manual</em>.</td>
</tr>
<tr>
<td><img src="image" alt="Code" /></td>
<td>Possible processor failure.</td>
<td>Refer to “Troubleshooting the Processor” in the <em>Dell PowerEdge R210 II Systems Owner’s Manual</em>.</td>
</tr>
<tr>
<td><img src="image" alt="Code" /></td>
<td>Memory failure</td>
<td>Refer to “Troubleshooting System Memory” in the <em>Dell PowerEdge R210 II Systems Owner’s Manual</em>.</td>
</tr>
<tr>
<td>Code</td>
<td>Causes</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>------------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Code 1" /></td>
<td>Possible expansion card failure.</td>
<td>Refer to “Troubleshooting an Expansion Card” in the <em>Dell PowerEdge R210 II Systems Owner’s Manual.</em></td>
</tr>
<tr>
<td><img src="image2.png" alt="Code 2" /></td>
<td>Possible video failure.</td>
<td>Refer to “Getting Help” in the <em>Dell PowerEdge R210 II Systems Owner’s Manual.</em></td>
</tr>
<tr>
<td><img src="image3.png" alt="Code 3" /></td>
<td>Hard drive failure.</td>
<td>Ensure that the diskette drive and hard drive are properly connected. For information on the drives installed in your system refer to: “Hard Drives” in the <em>Dell PowerEdge R210 II Systems Owner’s Manual.</em></td>
</tr>
<tr>
<td><img src="image4.png" alt="Code 4" /></td>
<td>Possible USB failure.</td>
<td>Refer to “Troubleshooting a USB Device” in the <em>Dell PowerEdge R210 II Systems Owner’s Manual.</em></td>
</tr>
<tr>
<td><img src="image5.png" alt="Code 5" /></td>
<td>No memory modules detected.</td>
<td>Refer to “Troubleshooting System Memory” in the <em>Dell PowerEdge R210 II Systems Owner’s Manual.</em></td>
</tr>
<tr>
<td><img src="image6.png" alt="Code 6" /></td>
<td>System board failure.</td>
<td>Refer to “Getting Help” in the <em>Dell PowerEdge R210 II Systems Owner’s Manual.</em></td>
</tr>
<tr>
<td><img src="image7.png" alt="Code 7" /></td>
<td>Memory configuration error.</td>
<td>Refer to “Troubleshooting System Memory” in the <em>Dell PowerEdge R210 II Systems Owner’s Manual.</em></td>
</tr>
</tbody>
</table>
NSM 2012/K Rear Panel Components

*Figure 3–24* illustrates a typical rear panel view of the SystemManager Platform.

<table>
<thead>
<tr>
<th>Code</th>
<th>Causes</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="Code 1" /> <img src="#" alt="Code 2" /> <img src="#" alt="Code 3" /> <img src="#" alt="Code 4" /></td>
<td>Possible system board resource and/or system board hardware failure.</td>
<td>Refer to “Getting Help” in the <em>Dell PowerEdge R210 II Systems Owner’s Manual.</em></td>
</tr>
<tr>
<td><img src="#" alt="Code 1" /> <img src="#" alt="Code 2" /> <img src="#" alt="Code 3" /> <img src="#" alt="Code 4" /></td>
<td>Possible system resource configuration error.</td>
<td></td>
</tr>
<tr>
<td><img src="#" alt="Code 1" /> <img src="#" alt="Code 2" /> <img src="#" alt="Code 3" /> <img src="#" alt="Code 4" /></td>
<td>Other failure.</td>
<td>Ensure that the optical drive and hard drives are properly connected. For the appropriate drive installed in your system,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Following are descriptions of each rear panel component as identified above:

**Table 3–4: Rear panel components**

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial Connector</td>
<td>Connects a serial device to the system.</td>
</tr>
<tr>
<td>Video Connector</td>
<td>Connects a VGA display to the system.</td>
</tr>
</tbody>
</table>

*Figure 3–24: Rear Panel of SystemManager Platform*
NIC Indicator Codes

*Figure 3–25* illustrates the NIC indicators and the status of each.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>eSATA</td>
<td>Connects additional storage devices.</td>
</tr>
<tr>
<td>USB Connectors (2)</td>
<td>Connects USB devices to the system. The ports are USB 2.0-compliant.</td>
</tr>
<tr>
<td>NIC Connectors (2)</td>
<td>Embedded 10/100/1000 NIC connectors.</td>
</tr>
<tr>
<td>System Status Indicator</td>
<td>▪ Lights blue during normal system operation.</td>
</tr>
<tr>
<td></td>
<td>▪ Lights amber when the system needs attention due to a problem.</td>
</tr>
<tr>
<td>System Identification Button</td>
<td>The system identification buttons on the front and back panels can be used to locate a particular system within a rack. When one of the buttons is pushed, the system status indicators on the front and back panels light blue until one of the buttons is pushed again.</td>
</tr>
<tr>
<td>System Identification Connector</td>
<td>Connects the optional system status indicator assembly through the optional cable management arm.</td>
</tr>
<tr>
<td>Power Supply</td>
<td>250 W power supply.</td>
</tr>
<tr>
<td>Retention Clip</td>
<td>Secures the power cable.</td>
</tr>
</tbody>
</table>

**LED** | **Color** | **Indicates** |
--- | --- | --- |
1. Link Indicator | Green | NIC is connected to a valid link on the network. at 1000 Mbps. |
|                  | Amber | NIC is connected to a valid link on the network. at 10/100 Mbps. |
2. Activity Indicator | Blinking Green | Data is being sent or received over the network. |
3. Both Link and Activity Indicators are off | | NIC is not connector to the network. |
NSM–2012K SystemManager Platform Keyboard/Monitor Tray

The Keyboard/Monitor Tray is an integrated 1 RU chassis that includes a flat-panel LCD monitor, keyboard, and touchpad mouse. NSM–2012K SystemManager Platforms are packaged with a 17 inch monitor. The entire tray slides out for convenient storage and operation within the equipment rack and the adjustable monitor tilts-up into place for operation.

The following illustration shows the keyboard, monitor, and mouse unit which ships with the NSM-2012K SystemManager Platform.

For notes regarding legacy platforms, refer to the Appendix, *Legacy Platforms*.

![Keyboard/Monitor Tray Illustration](image)

<table>
<thead>
<tr>
<th>1. Rack Rails</th>
<th>4. Keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. Tilt-Up LCD Monitor</td>
<td>5. Keyboard/Monitor Tray</td>
</tr>
<tr>
<td>3. LCD Monitor Controls</td>
<td></td>
</tr>
</tbody>
</table>

Figure 3–26: Keyboard / Monitor / Mouse Unit

**NOTE:** Harmonic does not support mixing the NSM–2003 SystemManager keyboard, monitor, and mouse unit with an NSM–2007 or NSM–2012 SystemManager Platform. This combination is known to result in display problems.

Following are descriptions of each section on the **Keyboard/Monitor** unit as itemized above.

a. **Rack Rails**

Two locking Rack Rails secure the Keyboard/Monitor Tray in your rack. Do not put additional weight on the tray when the Rack Rails are extended and the keyboard is in use.

b. **Tilt-Up LCD Monitor**

The Tilt-Up LCD Monitor provides the standard Windows user interface. The monitor is adjustable to the desired viewing angle.

**NOTE:** Always lay the monitor flat before unlocking the tray and re-inserting it into the rack. Damage to the LCD monitor may result if it remains upright when re-inserted into the rack.

c. **LCD Monitor Controls**
A set of **LCD Monitor Controls** (such as brightness, contrast, and power) is provided on the front of the Monitor case.

d. **Keyboard**

The **Keyboard** provides function keys, keypad, and a **TouchPad** (in place of a mouse).

e. **Keyboard/Monitor Tray**

The **Keyboard/Monitor Tray** houses all components and cable harnesses.

Figure 3–27: Keyboard / Monitor Unit Back Panel

Following are descriptions of sections on the back panel of the **Keyboard/Monitor** unit as itemized above.

a. **Power On/Off Switch**

b. **AC IN**

One AC IN connector is available on the unit.

c. **Video Connector**

- One 15-pin “D” connector (**Video/Keyboard/Mouse**) is provided for Keyboard, Monitor and Mouse functionality. Connect the Video/USB cable here.
- On the NSM-2012/K and NSM-2012/K, connections to the USB keyboard and mouse split from a single USB cable.
- On an NSM-2003, connections to the PS2 keyboard and mouse are split as two cables


Choose from the following topics:

- **NSM–2001 and NSM–2003 Description**
- **NSM–2007 and NSM–2007K Description**
- **NSM–2003 and NSM–2007K SystemManager Platform Keyboard/Monitor Tray**

**NOTE:** The SystemManager Platform consists of hardware and software components provided by other vendors and integrated by Harmonic into a system designed for monitoring and controlling Spectrum, ProBrowse, Harmonic MediaGrid, and MediaDeck systems. Contact Technical Support first for your support needs.
NSM-2001 and NSM-2003 Description
The NSM-2001 and NSM-2003 SystemManager Platforms (Dell™ PowerEdge™ 850) are comprised of both hardware and software components:

- The SystemManager’s hardware platform is a 1 RU Windows 2000® Professional Platform that typically features an Intel® Celeron® microprocessor with 512 MB of DDR2 memory and two integrated 10/100/1000 Mbps network interface controllers (NICs). Note that unit specifications can vary according to the date of shipment.
  - The NSM-2003 SystemManager Platform is packaged with a tray with keyboard, mouse, and 15” LCD monitor with PS2 connector cable. Refer to NSM-2003 and NSM-2007K SystemManager Platform Keyboard/Monitor Tray for more information.

CAUTION: Do not use the keyboard, mouse, or monitor from the NSM-2003 with the NSM-2007 or NSM-2007K Platform.

- The following applications are factory-installed:
  - **SystemManager Application**: This is the software component that runs on the SystemManager Platform. The application communicates with a Spectrum, Harmonic MediaGrid, or ProBrowse System over Ethernet, providing software update capability, network management, configuration, security, and fault monitoring services. The application also provides services such as DHCP and NTP. If you need to reinstall the application or upgrade to a later release, refer to Installing, Reinstalling, or Upgrading the SystemManager Application for step by step instructions.
  - **Symantec pcAnywhere**: Enables remote control and file transfer options for Technical Support.
  - **Telnet**: provides command line access to the SystemManager Platform.
  - **FLEXlm License Server**: Hands out licenses found in the license folder to MediaTools. Refer to About the FLEXlm License Server for additional information.
  - **vDHCP (Spectrum and ProBrowse systems)**: Used to auto configure IP addresses for units on a network.
  - **Microsoft Internet Explorer 6 or Microsoft Internet Explorer 7** browser.
  - **NTP for Windows (ProBrowse and Harmonic MediaGrid systems)**: Ensures a common time reference across components in a ProBrowse and/or Harmonic MediaGrid system.
  - **PuTTY**: Enables users to log in from the SystemManager Platform to other systems that support SSH.

NSM-2007 and NSM-2007K Description
The processor and memory for early NSM-2007 and NSM-2007K SystemManager platforms based on the Dell PowerEdge 860 are described in Table 3–1. For descriptions of other hardware and software components for some NSM-2007 and NSM-2007K SystemManager platforms, refer to NSM-2016, and NSM-2016K SystemManager Platform. For information on the Dell PowerEdge R210, refer to SystemManager Platforms.

Figure 3–28 illustrates a typical front panel view of an NSM-2001, NSM-2003, and NSM-2007/K with the front bezel removed.
Figure 3–28: NSM-2001, 2003, and 2007/K Front Bezel Panel

Following are descriptions of each front panel section, as itemized above:

a. **CD/DVD Drive**

One **CD/DVD Drive** is provided for loading software.

b. **Diagnostic LEDs (4)**

The **diagnostic LEDs** aid in diagnosing and troubleshooting the system. For more information, see the Diagnostic Indicator Codes section in the Dell documentation which ships with the unit.

c. **Power Button and LED**

The **Power Button** controls the power input to the system’s power supply. The power-on **LED** lights or blinks to indicate the status of power to the system. The power-on LED lights when the system is on. The LED is off when the system is off and power is disconnected from the system.

To exit from the standby state, briefly press the Power Button.

d. **NMI Button**

The **NMI Button** is used to troubleshoot software and device driver errors when using certain operating systems. This button can be pressed using the end of a paper clip. Use this button only if directed to do so by qualified support personnel, or by the operating system’s documentation.

e. **USB Ports (2)**

Connect USB 2.0-compliant devices to the system.

f. **Hard Drive Activity LED**

The green hard-drive activity LED flashes when the hard drives are being accessed.

g. **Video Connector**
Connects a monitor to the system.

h. **System Status Button & LED**

The **System Status Button** (also located on the front panel) can be used to locate a particular unit within a rack. Once the System ID Button on the rear is pushed, the **System Status LED** on the front of the unit flashes blue, making it easier to locate that unit from the front of a rack.

- **Blue LED:** Indicates normal system operation.
- **Amber LED:** Indicates that the system needs attention due to a system problem.


*Figure 3–29* illustrates a typical rear panel view of an NSM-2001, NSM-2003, and NSM-2007/K.

<table>
<thead>
<tr>
<th>1. Service Tag</th>
<th>5. USB Ports (2)</th>
<th>9. LAN 1 Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. AC IN</td>
<td>6. Serial Port</td>
<td>10. LAN 2 Port</td>
</tr>
<tr>
<td>3. Mouse Connector</td>
<td>7. Video Connector</td>
<td></td>
</tr>
</tbody>
</table>

*Figure 3–29: NSM-2001, 2003 and 2007/K Rear Panel View*

Following are descriptions of each rear panel section as itemized above:

a. **Service Tag**

Use the service tag number on the Dell Support site to get more information on the unit.

b. **AC IN**

One **AC IN** connector is available on the unit.

c. **Mouse Connector**

One 5-pin **PS2** connector (**Mouse**) is provided for the unit’s mouse.

For **PS2** mouse and keyboard devices, connect to these **PS2** ports. This includes the Keyboard, Mouse, and Monitor unit with NSM-2003 Platforms.

d. **Keyboard Connector**

One 5-pin **PS2** connector (**KBD**) is provided for the unit’s keyboard.

For **PS2** mouse and keyboard devices, connect to these **PS2** ports. This includes the Keyboard, Mouse, and Monitor unit with NSM-2003 Platforms.
Appendix A Legacy Platforms

e. **USB Ports**

Two connectors (USB0, USB1) are provided for USB. USB mouse and keyboard devices connect to these ports. This includes the Keyboard, Mouse, and Monitor (KMM) in the NSM-2007 Platform, where a single USB connection provides mouse and keyboard functionality.

f. **Serial Port**

One 9-pin “D” Serial Port connector is provided for connecting a serial device to the unit. This connector is unused.

g. **Video Connector**

One 15-pin “D” connector (Video) is provided for the Display Monitor.

h. **System Status Button & LED**

The System ID Button (also located on the front panel) can be used to locate a particular unit within a rack. Once the System ID Button on the rear is pushed, the System Status LED on the front of the unit flashes blue, making it easier to locate that unit from the front of a rack. The System Status LED can flash either a blue or amber light:

- **Blue LED:** Indicates normal system operation.
- **Amber LED:** Indicates that the system needs attention due to a system problem.

i. **LAN 1 Port**

One 8-pin RJ-45 connector (LAN 1) is provided for Ethernet connection (10/100/1000). Refer to About SystemManager Platform or Client PC Network Setup and Configuration for important information on correct port usage.

j. **LAN 2 Port**

One 8-pin RJ-45 connector (LAN 2) is provided for Ethernet connection (10/100/1000). Refer to About SystemManager Platform or Client PC Network Setup and Configuration for important information on correct port usage.

**NSM-2003 and NSM-2007K SystemManager Platform Keyboard/Monitor Tray**

For information about the Keyboard/Monitor tray, refer to NSM-2016K SystemManager Platform Keyboard/Monitor Tray.

**NOTE:** NSM-2003 SystemManager Platforms are packaged with 15.1 inch LCD monitors.

**NOTE:** Some models of the NSM-2003 Platform use a special combination video and PS2 cable while others use separate video and PS2 cables. The NSM-2007K Platform uses a combination video and USB cable.

**Support for non-English Keyboards**

To use a non-English keyboard with NSM-2007 or NSM-2007K SystemManager Platforms, it is necessary to install the “860.3” image on the SystemManager Platform. Refer to Reinstalling the SystemManager Platform Operating System on NSM-2016 or NSM-2016K. SystemManagers prepared prior to December 2007 may have an earlier version.
To check the image version, open the System Properties control panel, and click on the Support Information button, which displays the version in the following form: “Release 860.3 (Build 860.N)”.

For assistance using non-English keyboard layouts or upgrading your SystemManager Platform operating system, contact Technical Support.
Appendix B
Contacting the Technical Assistance Center

Harmonic Global Service and Support has many Technical Assistance Centers (TAC) located globally but virtually co-located where our customers can obtain technical assistance or request on-site visits from the Regional Field Service Management team. The TAC operates a Follow-The-Sun support model to provide Global Technical Support anytime, anywhere, through a single case management and virtual telephone system. Depending on time of day, anywhere in the world, we will receive and address your calls or emails in one of our global support centers. The Follow-the-Sun model greatly benefits our customers by provided continuous problem resolution and escalation of issues around the clock.

Report an issue online at:
http://harmonicinc.com/webform/report-issue-online

Table 3–5: Technical Assistance Center phone numbers and email addresses

<table>
<thead>
<tr>
<th>Region</th>
<th>Telephone Technical Support</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Americas</td>
<td>888.673.4896 or (888.MPEG.TWO) 408.490.6477</td>
<td><a href="mailto:support@harmonicinc.com">support@harmonicinc.com</a></td>
</tr>
<tr>
<td>EMEA</td>
<td>+44.1252.555.450</td>
<td><a href="mailto:emeasupport@harmonicinc.com">emeasupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Asia Pacific – Other Territories</td>
<td>+852.3184.0045 +65.6542.0050</td>
<td><a href="mailto:apacsupport@harmonicinc.com">apacsupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>India</td>
<td>+91.120.498.3199</td>
<td><a href="mailto:apacsupport@harmonicinc.com">apacsupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Russia</td>
<td>+7495.926.4608</td>
<td><a href="mailto:rusupport@harmonicinc.com">rusupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Mainland China</td>
<td>+86.10.8391.3313</td>
<td><a href="mailto:chinasupport@harmonicinc.com">chinasupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Japan</td>
<td>+81.3.5565.6737</td>
<td><a href="mailto:japansupport@harmonicinc.com">japansupport@harmonicinc.com</a></td>
</tr>
</tbody>
</table>

The Harmonic Inc. support website
http://www.harmonicinc.com/content/technical-support

Harmonic Inc. software download locations

<table>
<thead>
<tr>
<th>All Harmonic software except Cable Edge software</th>
<th>Software updates are available from the Harmonic website. Contact Harmonic Technical Support for login information.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cable Edge software</td>
<td>ftp://ftp.harmonicinc.com</td>
</tr>
</tbody>
</table>
The Harmonic Inc. corporate address

Harmonic Inc.
4300 North First St.
San Jose, CA 95134, U.S.A.
Attn: Customer Support

The corporate telephone numbers for Harmonic Inc. are:

Tel. 1.800.788.1330 (from the U.S. and Canada)
Tel. +1.408.542.2500 (outside the U.S. and Canada)
Fax. +1.408.542.2511
Appendix C
Safety and Regulatory Compliance Information

Legal Disclaimer: Information in this document is provided in connection with Harmonic products. Unless otherwise agreed in writing Harmonic products are not designed nor intended for any application in which the failure of the product could cause personal injury or death.

NOTE: The information in this appendix may apply to purchased products only.

Important Safety Instructions
This section provides important safety guidelines for operators and service personnel. Specific warnings and cautions are found throughout the guide where they apply, but may not appear here. Please read and follow the important safety information, noting especially those instructions related to risk of fire, electric shock or injury to persons. You must adhere to the guidelines in this document to ensure and maintain compliance with existing product certifications and approvals.
In this document, we use “product,” “equipment,” and “unit” interchangeably.
This equipment generates, uses, and can radiate radio frequency energy. It may cause harmful interference to radio communications if it is not installed and used in accordance with the instructions in this manual. Operation of this equipment in a residential area is likely to cause harmful interference. If this occurs, the user will be required to correct the interference at his or her own expense.
In event of conflict between the information in this document and information provided with the product or on our website for a particular product, this product documentation takes precedence.

Safety Symbols & Translated Safety, Warning & Caution Instructions (English)
To avoid personal injury or property damage, before you begin installing or replacing the product, read, observe, and adhere to all the following safety instructions and information. Harmonic products and/or product packaging may be marked with the safety symbols used throughout this document, when it is necessary to alert operators, users, and service providers to pertinent safety instructions in the manuals.
<table>
<thead>
<tr>
<th>Mark</th>
<th>Notes</th>
</tr>
</thead>
</table>
| ![Warning](attachment://image.png) | **Installing or Replacing the Product Unit Warning**  
- Only trained and qualified service personnel should be allowed to install, replace, or service this unit (refer AS/NZS 3260 Clause 1.2.14.3 Service Personnel).  
- Read the installation instructions before connecting the system to the power source.  
- When installing or replacing the unit, always make the ground connection first and disconnect it last.  
- Installation of the unit must comply with local and national electrical codes.  
- This unit is intended for installation in restricted access areas. A restricted access area can be accessed only through the use of special tool, lock and key or other means of security.  
- Use only specified replacement parts.  
- Do not use this unit in or near water. Disconnect all AC power before installing any options or servicing the unit unless instructed to do so by this manual. |
| ![Warning](attachment://image.png) | **Rack Mount Warning**  
- To prevent bodily injury when mounting or servicing this unit in a rack, special precautions must be taken to ensure your safety and stability of system:  
  - Conform to local occupational health and safety requirements when moving and lifting the equipment.  
  - Ensure that mounting of the unit by mechanical loading tools should not induce hazardous conditions.  
  - To avoid risk of potential electric shock, a proper safety ground must be implemented for the rack and each piece of equipment installed on it. |
| ![Warning](attachment://image.png) | **Chassis Warning**  
- Before connecting or disconnecting ground or power wires to the chassis, ensure that power is removed from the DC circuit.  
- To prevent personal injury or damage to the chassis, lift the unit only by using handles that are an integral part of the chassis, or by holding the chassis underneath its lower edge.  
- Any instructions in this guide that require opening the chassis or removing a board should be performed by qualified service personnel only.  
- Slots and openings in the chassis are provided for ventilation. Do not block them. Leave the back of the frame clear for air exhaust cooling and to allow room for cabling - a minimum of 6 inches (15.24 cm) of clearance is recommended. |
### Electric Shock Warning

- This unit might have more than one power cord. To reduce the risk of electric shock, disconnect the two power supply cords before servicing the unit.
- Before working on a chassis or working near power supplies, unplug the power cord on AC units.
- Do not work on the system or connect or disconnect cables during periods of lightning activity.
- This unit is grounded through the power cord grounding conductor. To avoid electric shock, plug the power cord into a properly wired receptacle before connecting the product input or outputs.
- Route power cords and other cables so that they are not likely to be damaged. Disconnect power input to unit before cleaning. Do not use liquid or aerosol cleaners; use only a damp cloth to clean chassis.
- Dangerous voltages exist at several points in this product. To avoid personal injury, do not touch exposed connections and components while power is on. Do not insert anything into either of the system's two power supply cavities with power connected.
- Never install an AC power module and a DC power module in the same chassis.
- Do not wear hand jewelry or watch when troubleshooting high current circuits, such as the power supplies.
- To avoid fire hazard, use only the specified correct type voltage and current ratings as referenced in the appropriate parts list for this unit. Always refer fuse replacement to qualified service personnel.
- This unit relies on the building's installation for short-circuit (overcurrent) protection. Ensure that a fuse or circuit breaker no larger than 1 20 VAC, 15A U.S. (240 VAC, 10A international) is used on the phase conductors (all current-carrying conductors).
- To avoid electrocution ensure that the rack has been correctly grounded before switching on the unit. When removing the unit remove the grounding connection only after the unit is switched off and unplugged.

<table>
<thead>
<tr>
<th>Mark</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="electric-shock-warning.png" alt="Electric Shock Warning" /></td>
<td><strong>Electric Shock Warning</strong></td>
</tr>
</tbody>
</table>
| **Warning** | - This unit might have more than one power cord. To reduce the risk of electric shock, disconnect the two power supply cords before servicing the unit.  
- Before working on a chassis or working near power supplies, unplug the power cord on AC units.  
- Do not work on the system or connect or disconnect cables during periods of lightning activity.  
- This unit is grounded through the power cord grounding conductor. To avoid electric shock, plug the power cord into a properly wired receptacle before connecting the product input or outputs.  
- Route power cords and other cables so that they are not likely to be damaged. Disconnect power input to unit before cleaning. Do not use liquid or aerosol cleaners; use only a damp cloth to clean chassis.  
- Dangerous voltages exist at several points in this product. To avoid personal injury, do not touch exposed connections and components while power is on. Do not insert anything into either of the system's two power supply cavities with power connected.  
- Never install an AC power module and a DC power module in the same chassis.  
- Do not wear hand jewelry or watch when troubleshooting high current circuits, such as the power supplies.  
- To avoid fire hazard, use only the specified correct type voltage and current ratings as referenced in the appropriate parts list for this unit. Always refer fuse replacement to qualified service personnel.  
- This unit relies on the building's installation for short-circuit (overcurrent) protection. Ensure that a fuse or circuit breaker no larger than 1 20 VAC, 15A U.S. (240 VAC, 10A international) is used on the phase conductors (all current-carrying conductors).  
- To avoid electrocution ensure that the rack has been correctly grounded before switching on the unit. When removing the unit remove the grounding connection only after the unit is switched off and unplugged. |
| ![Electrostatic Discharge (ESD) Caution](electrostatic-discharge-ESD-caution.png) | **Electrostatic Discharge (ESD) Caution** |
| **Caution** | - Follow static precaution at all times when handling this unit.  
- Always wear an ESD-preventive wrist or ankle strap when handling electronic components. Connect one end of the strap to an ESD jack or an unpainted metal component on the system  
- Handle cards by the faceplates and edges only; avoid touching the printed circuit board and connector pins.  
- Place any removed component on an antistatic surface or in a static shielding bag.  
- Avoid contact between the cards and clothing.  
- Periodically check the resistance value of the antistatic strap. Recommended value is between 1 and 10 mega-ohms (Mohms). |
Appendix C Safety and Regulatory Compliance

Information

Symboles de sécurité et traduits de sécurité, d’avertissement et Attention Instructions (français)

Pour éviter des blessures ou des dommages matériels, avant de commencer l’installation ou le remplacement du produit, lire, observer, et de respecter toutes les instructions et informations de sécurité suivantes. Produits harmoniques et / ou l’emballage du produit peuvent être marqués avec les symboles de sécurité utilisés dans le présent document, lorsque cela est nécessaire pour alerter les opérateurs, les utilisateurs et les fournisseurs de services de consignes de sécurité pertinentes dans les manuels.

<table>
<thead>
<tr>
<th>Mark</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Laser Radiation Warning]</td>
<td><strong>Laser Radiation Warning</strong>&lt;br&gt;Invisible laser radiation may be emitted from disconnected fibers or connectors. Do not stare into beams or view directly with optical instruments. Never operate a unit with a broken fibre or with a separated fiber connector.</td>
</tr>
<tr>
<td>![Lithium Battery Handling Safety Instructions]</td>
<td><strong>Lithium Battery Handling Safety Instructions</strong>&lt;br&gt;■ CALIFORNIA PERCHLORATE ADVISORY: Some lithium batteries may contain perchlorate material. The following advisory is provided: &quot;Perchlorate Material - special handling may apply, see: [<a href="http://www.dtsc.ca.gov/hazardous_waste/perchlorate/">www.dtsc.ca.gov/hazardous_waste/perchlorate/</a>] for information&quot;.</td>
</tr>
<tr>
<td>![Caution]</td>
<td>■ Risk of explosion if battery is replaced incorrectly or with an incorrect type&lt;br&gt;■ Dispose of used batteries according to the manufacturer’s instructions&lt;br&gt;■ There are no user-serviceable batteries inside Harmonic products. Refer to Harmonic qualified personnel only to service the replaceable batteries</td>
</tr>
</tbody>
</table>

Symboles de sécurité et traduits de sécurité, d’avertissement et Attention Instructions (français)
<table>
<thead>
<tr>
<th>Mark</th>
<th>Notes</th>
</tr>
</thead>
</table>
| ![Avertissement](image) | **Installation ou remplacement de l'unité de produit Avertissement**  
- Il est vivement recommandé de confier l'installation, le remplacement et la maintenance de ces équipements à des personnels qualifiés et expérimentés. (voir AS / NZS 3260 article 1.2.14.3 du personnel de service).  
- Avant de brancher le système sur la source d'alimentation, consulter les directives d'installation.  
- Lors de l'installation ou le remplacement de l'appareil, la mise à la terre doit toujours être connectée en premier et déconnectée en dernier.  
- L'équipement doit être installé conformément aux normes électriques nationales et locales.  
- Cet appareil est à installer dans des zones d'accès réservé. Ces dernières sont des zones auxquelles seul le personnel de service peut accéder en utilisant un outil spécial, un mécanisme de verrouillage et une clé, ou tout autre moyen de sécurité.  
- Utilisez uniquement des pièces de rechange spécifiées.  
- Ne pas utiliser ce produit dans l'eau ni à proximité de l'eau. Débrancher toutes les prises d'alimentation secteur avant d'installer des options ou d'effectuer l'entretien de l'unité, à moins d'instructions contraires dans le présent manuel. |
| ![Avertissement](image) | **Rack Monture Avertissement**  
Pour éviter les blessures corporelles lors du montage ou l'entretien de cet appareil dans un rack, des précautions particulières doivent être prises pour assurer votre sécurité et la stabilité du système:  
- Conformez-vous aux exigences de médecine du travail et de sécurité lorsque vous déplacez et soulevez le matériel.  
- Assurez-vous que le montage de l'appareil par des outils de chargement mécaniques ne doit pas induire des conditions dangereuses.  
- Pour éviter tout risque d'électrocution, le rack et chaque élément de l'équipement installé dans le rack doivent être correctement reliés à la terre. |
| ![Avertissement](image) | **Châssis Avertissement**  
- Avant de connecter ou de déconnecter les câbles d'alimentation (pôles et terre) du châssis, vérifiez que le circuit de courant continu est hors tension.  
- Pour éviter toute blessure ou des dommages au châssis, soulevez l'unité uniquement par les poignées du châssis lui-même ou en portant celui-ci par le bord inférieur.  
- Toutes les opérations du présent guide nécessitant l’ouverture du châssis ou le retrait d’une carte doivent être uniquement effectuées par du personnel d'entretien qualifié.  
- Le châssis est muni de fentes et d'ouvertures d'aération. Ne pas les bloquer. Dégager l’arrière du cadre pour permettre le refroidissement de l’évacuation d’air et laisser de la place au câblage; un dégagement d’au moins 15.24 cm (6 po) est recommandé. |
<table>
<thead>
<tr>
<th>Mark</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>🚨</td>
<td>Choc électrique Avertissement</td>
</tr>
<tr>
<td>✚</td>
<td>Il est possible que cette unité soit munie de plusieurs cordons d'alimentation. Pour éviter les risques d'électrocution, débrancher les deux cordons d'alimentation avant de réparer l'unité.</td>
</tr>
<tr>
<td>✚</td>
<td>Avant de travailler sur un châssis ou à proximité d'une alimentation électrique, débrancher le cordon d'alimentation des unités en courant alternatif.</td>
</tr>
<tr>
<td>✚</td>
<td>Ne pas travailler sur le système ni brancher ou débrancher les câbles pendant un orage.</td>
</tr>
<tr>
<td>✚</td>
<td>Ce unité est mis à la terre par le conducteur de protection intégré au cordon d'alimentation. Pour éviter les chocs électriques, brancher le cordon d'alimentation dans une prise correctement cable avant de raccorder les entrées ou sorties du unité.</td>
</tr>
<tr>
<td>✚</td>
<td>Installer les cordons d'alimentation et autres cables de sorte qu'ils ne risquent pas d’être endommagés. Couper l'alimentation avant nettoyage. Ne pas utiliser de nettoyant liquide ou en aérosol; utiliser seulement un linge humide.</td>
</tr>
<tr>
<td>✚</td>
<td>Des courants électriques dangereux circulent dans cet appareil. Afin d’éviter les lessures, ne pas toucher les connexions et composants exposés lorsque l'appareil est sous tension. Ne rien insérer dans l'une ou l'autre des cavités des prises de courant du système lorsque l'appareil est sous tension.</td>
</tr>
<tr>
<td>✚</td>
<td>N'installez jamais un module d'alimentation AC et un module d'alimentation DC dans le même châssis.</td>
</tr>
<tr>
<td>✚</td>
<td>Ne pas porter de bijoux aux mains ni de montre durant le dépannage des circuits à haute tension, comme les transformateurs.</td>
</tr>
<tr>
<td>✚</td>
<td>Pour prévenir les risques d'incendie, n'utiliser que le type, la tension et le courant nominal spécifiés dans la nomenclature des pièces de ce unité. Toujours confier le remplacement des fusibles à du personnel d'entretien qualifié.</td>
</tr>
<tr>
<td>✚</td>
<td>Pour ce qui est de la protection contre les courts-circuits (surtension), ce produit dépend de l'installation électrique du local. Vérifier qu'un fusible ou qu’un disjoncteur de 120 V alt., 15 A U.S. maximum (240 V alt., 10 A international) est utilisé sur les conducteurs de phase (conducteurs de charge).</td>
</tr>
<tr>
<td>✚</td>
<td>Pour éviter l'électrocution, assurez-vous que le rack a bien été mis à la terre avant de mettre l'unité en marche. Lors du retrait de l'unité, retirer le raccordement de terre seulement après avoir mis l'unité à l'arrêt et l'avoir débranchée.</td>
</tr>
</tbody>
</table>
### Sicherheit Symbole und übersetzt Sicherheit, Achtung & Vorsicht Anleitung (Deutsch)

Um Verletzungen oder Sachschäden zu vermeiden, bevor Sie mit der Installation oder Austausch des Produkts zu beginnen, zu lesen, zu beobachten, und sich an all den folgenden Sicherheitshinweise und Informationen. Harmonic Produkte und / oder Produktverpackungen können mit den Sicherheitssymbole in diesem Dokument verwendet werden, markiert, wenn es notwendig ist für die Betreiber, Anwender und Dienstleister, um relevante Sicherheitsanweisungen in den Handbüchern zu alarmieren.

<table>
<thead>
<tr>
<th>Mark</th>
<th>Notes</th>
</tr>
</thead>
</table>
| ![Exclamation Mark] | Les décharges électrostatiques (ESD) **Attention**
- Respec **t**er systématiquement les precautions relatives aux charges électrostatiques durant la manipulation de cet unité. 
- Portez toujours un poignet ou la cheville bracele **t** antistatique préventive lors de la manipulation des composants électroniques. Branchez une extrémité de la sangle à une prise ESD ou d'un composant métallique non peinte sur le système. 
- Manipulez les cartes en les faces avant et les bords seulement; éviter de toucher la carte de circuit imprimé et les broches du connecteur.
- Placer un composant retiré sur une surface antistatique ou dans un sac de protection statique.
- Éviter tout contact entre les cartes et les vêtements.
- Vérifier périodiquement la valeur de résistance de la sangle antistatique. Valeur recommandée est comprise entre 1 et 10 méga-ohms (Mohms). |
| ![Exclamation Mark] | Rayonnement laser **Attention**
- Rayonnement laser invisible peut être émis à partir de fibres ou les connecteurs débranchés. Ne pas regarder en faisceaux ou regarder directement avec des instruments optiques. Ne jamais faire fonctionner une unité en cas de bris d’une fibre ou de séparation d’un connecteur de fibre. |
| ![Exclamation Mark] | Batterie au lithium **Manipulation instructions de sécurité**
- Perchlorate pour la Californie Consultatif: Certaines batteries au lithium, peuvent contenir du perchlorate. le texte qui suit consultatif est prévu: "Présence de perchlorate - une manipulation spéciale peut s’appliquer, voir: [www.dtsc.ca.gov/hazardous waste/perchlorate/ for information](http://www.dtsc.ca.gov/hazardous waste/perchlorate/ for information)". |
| ![Exclamation Mark] | **Attention**
- Il y a danger d’explosion si la batterie est remplacée de manière incorrecte ou par une batterie de type incorrect.
- Mettre au rebut les batteries usagées conformément aux instructions du fabricant.
- Les batteries des produits Harmonic ne peuvent pas être réparées ni entretenues par l’utilisateur. Ne confir l’entretien des batteries remplaçables qu’à du personnel compétent de Harmonic. |
<table>
<thead>
<tr>
<th>Mark</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Installation oder den Austausch des Produkts Einheit Warnung</strong></td>
</tr>
<tr>
<td>▪</td>
<td>Das Installieren, Ersetzen oder Bedienen dieser Ausrüstung sollte nur geschultem, qualifiziertem Personal gestattet werden (siehe AS / NZS 3260 Clause 1.2.4.3 Servicepersonal)</td>
</tr>
<tr>
<td>▪</td>
<td>Lesen Sie die Installationsanweisungen, bevor Sie das System an die Stromquelle anschließen.</td>
</tr>
<tr>
<td>▪</td>
<td>Der Erdanschluß muß bei der Installation der Einheit immer zuerst hergestellt und zuletzt abgetrennt werden.</td>
</tr>
<tr>
<td>▪</td>
<td>Die Installation der Geräte muss den Sicherheitsstandards entsprechen.</td>
</tr>
<tr>
<td>▪</td>
<td>Verwenden Sie nur die angegebenen Ersatzteile</td>
</tr>
<tr>
<td></td>
<td><strong>Rack-Montage-Warnung</strong></td>
</tr>
<tr>
<td>▪</td>
<td>Zur Vermeidung von Körperverletzung beim Anbringen oder Warten dieser Einheit in einem Gestell müssen Sie besondere Vorkehrungen treffen, um sicherzustellen, daß das System stabil bleibt:</td>
</tr>
<tr>
<td>▪</td>
<td>Entsprechen den lokalen Arbeitsschutzanforderungen beim Bewegen und Heben der Ausrüstung.</td>
</tr>
<tr>
<td>▪</td>
<td>Stellen Sie sicher, dass die Montage des Gerätes durch mechanische Belastung Werkzeuge sollten nicht gefährlichen Bedingungen zu induzieren.</td>
</tr>
<tr>
<td>▪</td>
<td>Um das Risiko von möglichen elektrischen Schlag zu vermeiden, muss mit einer angemessenen Erdung für Rack und jedes Gerät installiert ist implementiert werden.</td>
</tr>
<tr>
<td></td>
<td><strong>Chassis Warnung</strong></td>
</tr>
<tr>
<td>▪</td>
<td>Gleichstrom-Unterbrechung Bevor Sie Erdungs- oder Stromkabel an das Chassis anschließen oder von ihm abtrennen, ist sicherzustellen, daß der Gleichstrom-Stromkreis unterbrochen ist.</td>
</tr>
<tr>
<td>▪</td>
<td>Um Verletzungen und Beschädigung des Chassis zu vermeiden, sollten Sie das Chassis nicht an den Henkeln auf den Elementen (wie z.B. Stromanschlüsse, Kühlungen oder Karten) heben oder kippen; oder indem Sie es unterhalb der Unterkante packen.</td>
</tr>
<tr>
<td>▪</td>
<td>Alle Hinweise in diesem Handbuch, die das Öffnen benötigen Sie das Gehäuse oder das Entfernen eines Board sollte nur von qualifiziertem Fachpersonal durchgeführt werden.</td>
</tr>
<tr>
<td>▪</td>
<td>Für Schlitzte und Öffnungen im Chassis vorgesehen. Blockieren Sie sie nicht. Lassen Sie die Rückseite des Rahmens frei für Abluftkühlung und um Platz für die Verkabelung ermöglichen - ein Minimum von 6 Zoll (15,24 cm) Abstand wird empfohlen</td>
</tr>
<tr>
<td>Mark</td>
<td>Elektroschock-Warnung</td>
</tr>
<tr>
<td>------</td>
<td>----------------------</td>
</tr>
<tr>
<td>❖</td>
<td>Diese Einheit hat möglicherweise mehr als ein Netzkabel. Zur Verringerung der Stromschlaggefahr trennen Sie beide Netzgerätekabel ab, bevor Sie die Einheit warten.</td>
</tr>
<tr>
<td>❖</td>
<td>Vor der Arbeit an einem Chassis für Arbeiten in der Nähe Stromversorgung, ziehen Sie das Netzkabel mit Netzeinheiten.</td>
</tr>
<tr>
<td>❖</td>
<td>Arbeiten Sie nicht am System und schließen Sie keine Kabel an bzw. trennen Sie keine ab, wenn es gewittert.</td>
</tr>
<tr>
<td>❖</td>
<td>Dieses Gerät ist über das Netzkabel Erdungsleiter geerdet. Um einen Stromschlag zu vermeiden, stecken Sie das Netzkabel in eine Steckdose richtig verdrahtet, bevor Sie das Produkt Eingang oder Ausgänge.</td>
</tr>
<tr>
<td>❖</td>
<td>Verlegen Sie Netzkabel und andere Kabel, so dass sie wahrscheinlich nicht beschädigt werden. Trennen Eingangsleistung Einheit vor der Reinigung. Verwenden Sie keine flüssigen oder Aerosolreiniger; nur mit einem feuchten Tuch zu reinigen Chassis.</td>
</tr>
<tr>
<td>❖</td>
<td>Ein Wechselstrommodul und ein Gleichstrommodul dürfen niemals in demselben Chassis installiert werden.</td>
</tr>
<tr>
<td>❖</td>
<td>Tragen Sie keine Hand Schmuck oder schauen Sie bei der Fehlersuche hohen Stromkreise, wie beispielsweise die Stromversorgung.</td>
</tr>
<tr>
<td>❖</td>
<td>Um die Brandgefahr zu vermeiden, verwenden Sie nur den genannten richtige Art von Spannung und Strom Ratings als in der entsprechenden Stückliste für diese Einheit verwiesen. Beziehen sich immer auf Austausch der Sicherung von qualifiziertem Fachpersonal.</td>
</tr>
<tr>
<td>❖</td>
<td>Dieses Produkt ist darauf angewiesen, daß im Gebäude ein Kurzschluß- bzw. Überstromschutz installiert ist. Stellen Sie sicher, daß eine Sicherung oder ein Unterbrecher von nicht mehr als 240 V Wechselstrom, 10 A (bzw. in den USA 120 V Wechselstrom, 15 A) an den Phasenleitern (allen Stromführenden Leitern) verwendet wird.</td>
</tr>
<tr>
<td>❖</td>
<td>Um einen Stromschlag zu vermeiden, sicherzustellen, dass die Zahnstange wurde korrekt vor dem Einschalten des Gerätes geerdet. Beim Entfernen der Einheit entfernen Sie die Masseverbindung nur, nachdem das Gerät ausgeschaltet und der Netzstecker gezogen.</td>
</tr>
</tbody>
</table>
## Site Preparation Instructions

**NOTE:** Only trained and qualified service personnel (as defined in IEC 60950 and AS/NZS 3260) should install, replace, or service the equipment. Install the system in accordance with the U.S. National Electric Code if you are in the United States.

### 1. Preparing & Choosing a Site for Installation
- To ensure normal system operation, plan your site configuration and prepare the site before installation.
- Install the unit in a restricted access area.
Choose a site with a dry, clean, well-ventilated and air-conditioned area.

Choose a site that maintains an ambient temperature of 32 to 104°F (0 to 40°C)

2. Creating a Safe Environment

- Connect AC-powered systems to grounded power outlets or as per local regulations.
- Do not move or ship equipment unless it is correctly packed in its original wrapping and shipping containers.
- Only allow Harmonic trained personnel to undertake equipment service and maintenance. Do not permit unqualified personnel to operate the unit.
- Wear ear protection when working near an NSG Pro platform for a longer period of time.

3. Rack Mounting the Unit

- Install the system in an open rack whenever possible. If installation in an enclosed rack is unavoidable, ensure that the rack has adequate ventilation.
- Reliable earthing of rack-mounted equipment should be maintained. Particular attention should be given to supply connections other than direct connections to the branch circuit (e.g. use of power strips). This unit should be mounted at the bottom of the rack if it is the only unit in the rack.
- When mounting this unit in the partially filled rack, load the rack from the bottom to the top with the heaviest component at the bottom of the rack.
- If the rack is provided with stabilizing devices, install the stabilizers before mounting or servicing the unit in the rack.
- The rack must be anchored to an immovable support to prevent it from tipping when the unit is mounted on it. The rack must be installed according to the rack manufacturer’s instructions.
- Disconnect all power and external cables before lifting the unit. Depending on the weight of the unit, more than one person might be required to lift it.

4. Power Considerations

a. AC Power

- Adding to the system a UPS (Uninterrupted Power Supply) and an AVR (Automated Voltage Regulator) is highly recommended.
- Installing the main power supply by a qualified electrician, according to power authority regulations. Make sure all powering are wired with an earth leakage, according to local regulations.
- It is recommended to install the encoder within 1.5m (approximately 5 feet) from an easily accessible grounded AC outlet.
- When the encoder is rack-mounted, ensure that the rack is correctly grounded.

b. DC Power

- Ensure a suitable overcurrent device is in-line between the equipment and the power source.
- Connect DC-input power supplies only to a DC power source that complies with the safety extra-low voltage (SELV) requirements in the UL60950-1, CAN/CSA-C22.2 No. 60950-1-03, AS/NZS 60950-1, EN/IEC 60825-1, 21 CFR 1040, EN 60950-1, and IEC 60950-1 standards.
- Ensure that power is removed from the DC circuit before installing or removing power supplies.

5. Handling Fiber Channel Cables

- Always read and comply with the handling instructions on the shipping container.
- Follow all ESD precautions and approved fiber cleaning procedures.
The fiber is made of a very pure, expensive glass and should be treated with great care. Handle fibers only in areas that are very clean and do not contain sharp objects.

Wear finger cots or gloves as dirt and oils can damage the fiber and contaminate connectors.

Do not allow kinks or knots to develop in the fiber. If tangles occur, carefully work out the tangles avoiding pulling or bending the fibre beyond its bend radius.

Always use the correct tools for stripping and cleaving the fiber. It will save time and reduce breakage caused by scratches.

If you must secure a bundle of fiber cables together, avoid plastic and metal tie wraps; secure with velcro instead.

6. Disposing of the Unit

Dispose of the unit and its components (including batteries) as specified by all national laws and regulations.

Product End-of-Life Disassembly Instructions

For disassembly instructions, please call the technical support in order to remove components requiring selective treatment, as defined by the EU WEEE Directive (2012/19/EU). See Contacting the Technical Assistance Center.

Product Disassembly Process

1. Disassemble equipment at a dedicated area only, gather the needed tools for disassembly.
2. Remove covers, housing, etc.
3. Remove and separate sub-assemblies (i.e. cables, metals, displays, fans, etc.).
4. Separate hazardous materials from the remainder of the material.
   a. Sort hazardous materials into their different types (i.e., batteries, hazardous liquids, hazardous solids, fiberglass, etc.).
   b. Proceed with hazardous waste management processes only.
5. Identify re-usable materials/sub-assemblies and separate these from the rest of the material.
6. Identify and separate recyclable materials as per below examples:
   a. Scrap material to be sent to smelter(s).
   b. E-waste such as displays, CPU’s, cables and wires, hard drives, keyboards, etc.
   c. Metals such as steel, brass, and aluminum.
   d. Plastics such as fan casings, housings, covers, etc.
   e. Fiber optics and plastic tubing not containing electrical or data wiring.

Safety Rules (English)

Recycler personnel are to wear personal protective equipment including proper eye protection, proper hand protection, and proper breathing protection if needed.

Recycler personnel shall be experienced with using the proper tools required for disassembling equipment. Untrained personnel shall not disassemble Harmonic products. Unfamiliarity with tools can cause damage and injury.

Règles de sécurité (French)

Le personnel du recycleur doit porter de l’équipement de protection individuelle, y compris des lunettes, des gants et un masque de protection appropriés au besoin.
Le personnel du recycleur doit avoir de l’expérience des outils de démontage de l’appareil. Les produits Harmonic ne doivent pas être démontés par du personnel non qualifié. Une mauvaise connaissance des outils peut causer des dommages et des blessures.

**EU Manufacturer's Declaration of Conformity**

This equipment is in compliance with the essential requirements and other provisions of Directives 73/23/EEC and 89/336/EEC as amended by Directive 93/68/EEC.

**NOTE:** For specifics, about which standards have been applied, refer to the Declaration of Conformity of the product on Harmonic website at [Product Regulatory Compliance](https://www.harmonicinc.com) or contact Harmonic Compliance Team at regulatory.compliance@harmonicinc.com

**Electromagnetic Compatibility Notices – Class A**

a. **FCC Verification Statement (USA)**

   This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

   This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case users will be required to correct the interference at their own expense.

   Connections between the Harmonic equipment and other equipment must be made in a manner that is consistent with maintaining compliance with FCC radio frequency emission limits. Modifications to this equipment not expressly approved by Harmonic may void the authority granted to the user by the FCC to operate this equipment and you may be required to correct any interference to radio or television communications at your own expense.

b. **ICES–003 Statement (Canada)**

   **English:** This Class A digital apparatus complies with Canadian ICES-003.

   **French:** Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

c. **CE Declaration of Conformity (European Union)**

   This product has been tested in accordance too, and complies with the Low Voltage Directive (2014/30/EU) and EMC Directive (2014/35/EU). The product has been marked with the CE Mark to illustrate its compliance.
Appendix C Safety and Regulatory Compliance

Electromagnetic Compatibility Notices – Class A

d. VCCI Class A Warning (Japan)

English translation of the notice above:
This is a Class A product based on the standard of the Voluntary Control Council for Interference (VCCI) from Information Technology Equipment. If this equipment is used in a domestic environment, it may cause radio interference. When such trouble occurs, the user may be required to take corrective actions.

e. BSMI EMC Notice (Taiwan)

English translation of the notice above:
This is a Class A Information Product, when used in residential environment, it may cause radio frequency interference, under such circumstances, the user may be requested to take appropriate counter measures.

f. Class A Warning (Korea)

English translation of the notice above:
This is a Class A device and is registered for EMC requirements for industrial use. The seller or buyer should be aware of this. If this was sold or purchased by mistake, it should be replaced with a residential-use type.

g. Class A Statement (China)

English translation of the notice above:
This is a Class A product, in a residential environment, it may cause radio frequency interference. In such circumstances, the user may be required to take appropriate counter measures.
When labeled with the CCC marking, the product meets the applicable safety and EMC requirements for China. This is a Class A product. In a domestic environment this product may cause radio interference, in which case the user may be required to take adequate measures.

h. Class A Warning – CISPR 22 (AS/NZS)

Warning (English)
This is a class A product. In a domestic environment this product may cause radio interference in which case the user may be required to take adequate measures.

Attention (French)
Il s’agit d’un produit de classe A. Dans un environnement local, ce produit peut entraîner des perturbations radioélectriques, auquel cas l’utilisateur devra éventuellement prendre des mesures adéquates.

Product Regulatory Compliance

Harmonic products are typically tested to the latest safety and electromagnetic compatibility (EMC) specifications and test methods, and are marked with one or more of the following regulatory/certification markings. Some of the certification markings will vary depending on what certifier was used to obtain a certification.

Please visit Harmonic Product Regulatory Compliance page to view information on applied safety & EMC standards and regulatory marks on Harmonic products. You can also email us at regulatory.compliance@harmonicinc.com for assistance on regulatory compliance for Harmonic products.

Product Regulatory Compliance Markings

Table 3–6: Regulatory Compliance Markings

<table>
<thead>
<tr>
<th>Country/Region</th>
<th>Testing Standard/ Specification</th>
<th>Certification Type</th>
<th>Regulatory Mark Name</th>
<th>Product Marketing</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA/Canada</td>
<td>FCC CFR 47 Part 15, Class A, ICES-003: Issue 5, 2012; Class A</td>
<td>EMC</td>
<td>FCC Class A Statement</td>
<td><img src="https://example.com/fcc-class-a.png" alt="FCC Class A Statement" /></td>
</tr>
</tbody>
</table>

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference which may cause undesired operation.
## Table 3–6: Regulatory Compliance Markings

<table>
<thead>
<tr>
<th>Country/Region</th>
<th>Testing Standard/Specification</th>
<th>Certification Type</th>
<th>Regulatory Mark Name</th>
<th>Product Marketing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Germany</td>
<td>EN 60950-1; EN60825-1 (for laser)</td>
<td>Safety</td>
<td>GS</td>
<td></td>
</tr>
<tr>
<td>Mexico</td>
<td>NOM-019-SCFI-1998</td>
<td>Safety</td>
<td>NOM</td>
<td></td>
</tr>
<tr>
<td>Taiwan</td>
<td>CNS 14336-1:2010; CNS 13438:2006; Class A</td>
<td>Safety and EMC</td>
<td>BSMI Certification (RPC Number &amp; Class A Warning)</td>
<td></td>
</tr>
<tr>
<td>Japan</td>
<td>VCCI V-3/2013.04; CISPR 22:2008, Class A</td>
<td>EMC</td>
<td>VCCI</td>
<td></td>
</tr>
<tr>
<td>Australia and New Zealand</td>
<td>AS/NZS CISPR22:2009+A1:2010; Class A</td>
<td>Safety</td>
<td>C-Tick</td>
<td></td>
</tr>
<tr>
<td>Korea</td>
<td>KN22 Class A and KN 24</td>
<td>EMC</td>
<td>KC</td>
<td></td>
</tr>
</tbody>
</table>
Product Environmental Compliance

Harmonic manufactures high quality and innovative IT and telecommunications equipment, video delivery infrastructure solutions and services for its customers worldwide. Harmonic is committed to providing our customers with safe and environmentally friendly products that are compliant with all relevant regulations, customer specifications, and environmental legislation, including the directives described below.

EU RoHS

In July 2006, the European Union’s (EU) Directive (2002/95/EC) on the Restriction of the use of certain Hazardous Substances (RoHS) in Electrical and Electronic Equipment (EEE) went into effect, and in July, 2011, the European Union’s RoHS Recast Directive (2011/65/EU) also known as RoHS II entered into force.

Harmonic understands the environmental risks associated with the substances covered by the RoHS Directive and has committed to eliminating or reducing the use of these, as well as other environmentally sensitive substances in our products. Harmonic also continues to comply with the requirements under RoHS II.

For more information, please visit EU RoHS directive page at official EU website.


Restricted Substance Statement

Harmonic products contain less than the permitted limits for the six restricted substances except where exemptions published in the RoHS2 Directive are applicable. This statement is based on vendor-supplied analysis or material certifications, and/or lab test results of the component raw materials used in the manufacture of Harmonic products.

Table 3–7: Restricted Substances

<table>
<thead>
<tr>
<th>Restricted Substance</th>
<th>Permitted Limit*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cadmium (Cd)</td>
<td>≤0.01%</td>
</tr>
<tr>
<td>Lead (Pb)</td>
<td>≤0.1%</td>
</tr>
<tr>
<td>Chromium (VI) (Cr (VI))</td>
<td>≤0.1%</td>
</tr>
<tr>
<td>Mercury (Hg)</td>
<td>≤0.1%</td>
</tr>
</tbody>
</table>
**EU REACH**

REACH (Registration, Evaluation, Authorization and restriction of Chemicals) (EC 1907/2006) is a European Union’s regulation on chemicals and their safe use which came into force in June, 2007. Harmonic supports the basic aim of REACH in improving the protection of human health and environment through the better and earlier identification of intrinsic properties of chemical substances. Harmonic products are considered “articles” under REACH; therefore, we are required to provide recipients of our products with information on Substance of Very High Concern (SVHC) present in concentration above 0.1% (w/w).

Substances in our products are not intended to be released under normal or reasonably foreseeable conditions of use; therefore, the registration requirement in REACH Article 7(1) does not apply to our products.

For more information, please visit REACH regulation page at official EU website.

http://ec.europa.eu/environment/chemicals/reach/reach_en.htm

**China RoHS**

China’s regulation on restriction of the use of certain hazardous substances commonly (China RoHS), is applicable to all Electronic and Information Products (EIPs) and parts sold in China after March 01, 2007. China RoHS regulation restricts the use of the same six substances as the European Union’s ROHS, but has requirements for product labeling and regulated substance information disclosure.

Harmonic complies with China RoHS Phase I for labeling and information disclosure requirements and continues to monitor new developments in China RoHS Phase II towards substance restriction and certification program.

For more information, please visit China RoHS regulation page at official US export website.

http://www.export.gov/china/doingbizinchina/

---

**Table 3–7: Restricted Substances**

<table>
<thead>
<tr>
<th>Restricted Substance</th>
<th>Permitted Limit*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polybrominated biphenyls (PBBs)</td>
<td>≤0.1%</td>
</tr>
<tr>
<td>Polybrominated diphenyl ether (PBDE)</td>
<td>≤0.1%</td>
</tr>
</tbody>
</table>

*Homogeneous material definition as per the EU Directive.
China RoHS Disclosure Report

Below table shows the presence of hazardous substances, or elements in Harmonic products, if the part is present.

This table shows those components where hazardous substances may be found in Harmonic products based on, among other things, material content information provided by third party suppliers. These components may or may not be part of the product.

除非特殊注明，该表所示哈雷公司产品的环保使用期限均为 20 年。该环保使用期限的有效条件为：必须遵循该产品使用手册的规定，对该产品进行使用或存储。

The Environmental Protective Use Period for Harmonic products is 20 years unless displayed otherwise on the product. The EPLUP period is valid only when the products are operated or stored as per the conditions specified in the product manual.

<table>
<thead>
<tr>
<th>部件名称 (Part name)</th>
<th>有毒有害物质或元素 (Hazardous Substance)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>铅 (PB)</td>
</tr>
<tr>
<td>印刷线路板 (Printed Circuit Assemblies)</td>
<td>X</td>
</tr>
<tr>
<td>机械组件 (Mechanical Subassemblies)</td>
<td>X</td>
</tr>
<tr>
<td>光学组件 (Optical Subassemblies)</td>
<td>X</td>
</tr>
<tr>
<td>电源 (Power Supplies)</td>
<td>X</td>
</tr>
<tr>
<td>缆线 / 线束 (Cables, harnesses)</td>
<td>X</td>
</tr>
<tr>
<td>屏幕 / 显示器 (Screens, Monitors)</td>
<td>X</td>
</tr>
<tr>
<td>金属零件 (Metal Parts)</td>
<td>X</td>
</tr>
<tr>
<td>塑料 / 发泡材料 (Plastics, foams)</td>
<td>O</td>
</tr>
<tr>
<td>电池 (Batteries)</td>
<td>O</td>
</tr>
</tbody>
</table>

O: 表示在该部件的所有均质材料中，此类有毒有害物质的含量均小于 SJ/T11363-2006 标准所规定的限量。O: Indicates the content of the toxic and hazardous substances at the homogeneous material level of the parts is below the limit defined in SJ/T 11363 2006 standard.

X: 表示至少在该部件的某一均质材料中，此类有毒有害物质的含量超出 SJ/T11363-2006 标准规定的限量。X: Indicates that the content of the toxic and hazardous substances in at least one of the homogeneous materials of the parts is above the limit defined in SJ/T 11363 2006 standard.
Other RoHS and REACH type Regulations

Harmonic will comply with RoHS and REACH type regulations evolving in other countries, if they become relevant to our products or in markets where we sell our products.

Waste Electrical and Electronic Equipment (WEEE)

European Parliament and the Council of the European Union’s WEEE Directive (2002/96/EC) came into force on August, 2005 and, were more recently amended in July, 2012. This directive encourages the reuse, recycling, and recovery of WEEE and to improve the environmental performance of all operators involved in the life cycle of electrical and electronic equipment, especially those dealing with WEEE. Harmonic ensures that all requirements for registration, reporting, design and data tracking are complied with to meet the objectives of the WEEE directive.

For more information, please visit WEEE directive page at official EU website.


Battery Directive

In September 2006, the European Union’s Directive 2006/66/EC (Battery Directive) came into force with an aim to prohibit the sale of batteries and accumulators containing hazardous substances and to set rules and promote collection, treatment, recycling and disposal of waste batteries and accumulators. This directive applies to spent batteries collected together with WEEE and requires their removal and separate collection. Once removed from WEEE, spent batteries are governed by the Battery Directive. Harmonic uses lithium batteries in its products and our responsibility under the Battery Directive is taken care of under our WEEE Take-Back program.

For more information, please visit Batteries and Accumulators directive page at official EU website.

http://ec.europa.eu/environment/waste/batteries/

Harmonic is committed to manufacturing environmentally safe products for the community, and will make reasonable efforts and required adjustments to its practices, if necessary, to comply with various environmental directives and industry initiatives on the elimination of hazardous substances, labeling, marking, certification and registration as required in markets where we sell our products.

Download Harmonic’s Environmental Compliance Statement at the following location:


WEEE Take-Back Request Program

In order to assist EU member states to preserve, protect and improve the quality of the environment, protect human health and utilize natural resources prudently and rationally, Harmonic strives to recycle in compliance with the WEEE Directive any of its products that cannot be re-used.

Harmonic’s customers should:

- Not discard equipment in household or office garbage
- Arrange proper recycling of unneeded equipment. For the take-back of Harmonic equipment, customers must:
  - Collect the information required to complete Harmonic’s WEEE Take-Back Request form
Complete and submit the online WEEE Take-Back Request form. Please note that forms must be fully completed in order to prevent process delays

- Receive instant online confirmation indicating the reference number
- Receive the End of Life (EOL) asset return authorization number and instruction for EOL asset return

- Not ship EOL product to Harmonic without a Harmonic-provided EOL asset return authorization number

The crossed-out wheeled bin symbol on a Harmonic-branded commercial product indicates that the product should not be disposed of along with municipal waste, but invites our customers to return the product to us under Harmonic’s WEEE Take-Back program for product disposal.

Harmonic will pay for the cost of shipping and will provide a Certificate of Recycling or a Certificate of Destruction upon request. For more information on collection, reuse and recycling or to initiate the WEEE take-back process, please complete the form at http://www.harmonicinc.com/webform/weee-takeback-request or contact Harmonic Technical Assistance Center (TAC) or email RMA team at rma.emea@harmonicinc.com.

Compliance with additional country specific environmental, safety and EMC standards:

In addition to above listed standards and compliance regulations, Harmonic products may also be compliant with other country specific environmental, safety and EMC requirements. Please contact Harmonic Compliance Team at regulatory.compliance@harmonicinc.com or your local sales representative for more information about compliance with particular country or standard.